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The camera automatically sets the exposure by measuring the levels of 
light from the photo’s composition and the position of a subject. If the 
exposure set by the camera is higher or lower than you expected, you can 
adjust the exposure value manually. The exposure value is adjustable in ±3 
increments. The camera displays the exposure warning in red for each step 
beyond ±3 range.

To adjust the exposure value, while holding down [W], scroll the jog 
dial. You can also adjust the exposure value by pressing [f], and then 
selecting EV.

You can check the exposure value by the position of the exposure level 
indicator.

Exposure level 

indicator

Increased exposure  

(brighter)

Decreased exposure  

(darker) 

Exposure warning Standard exposure index

-2

Original

+2

 

Exposure compensation



Shooting Functions

103103

Shooting FunctionsShooting Functions

When you cannot achieve an appropriate exposure because of a strong 
color contrast, lock the exposure, and then capture a photo.

To lock the exposure value, adjust the photo’s exposure, and then press the 
custom button.

After locking the exposure, aim the lens where you desire, and then press 
[Shutter].

• Set a function of the custom button to AEL to lock the current exposure 
value. (p. 150)

• This feature is not available in Manual mode.

Exposure lock
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The functions available for video are explained below.

Movie size

Set the movie size.

To set movie size 
options,

 
In Shooting mode, press [m] → 6 → Movie Size →  

an option.

Icon Size Recommended for

1920X1080 (60 fps) (16:9) View on a Full HDTV.

1920X1080 (30 fps) (16:9) View on a Full HDTV. 

1920X1080 (15 fps) (16:9)
View on a Full HDTV. (Available only 
with some Smart Filter options.)

1920X810 (24 fps)  
(Approx. 2.35:1)

View on an HDTV.

1280X720 (60 fps) (16:9) View on an HDTV.

1280X720 (30 fps) (16:9) View on an HDTV.

640X480 (30 fps) (4:3) View on a TV.

320X240 (30 fps) (4:3)
Post on a website using the wireless 
network (30 seconds maximum).

Movie quality

Set the Movie quality.

To set movie 
quality options,

 
In Shooting mode, press [m] → 6 → Movie Quality → 

an option.

Icon Extension Description

MP4 (H.264) Normal: Record videos in normal quality.

MP4 (H.264) HQ: Record videos in high quality.

Video functions
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Multi Motion

Set the playing speed of a video.

To set playing 
speed options,

In Shooting mode, press [m] → 6 → Multi Motion → 

an option.

Icon Description

x0.25: Record a video and play it at 1/4 normal speed. (Available 
only with 640x480 or 320x240)

x0.5: Record a video and play it at 1/2 normal speed. (Available 
only with 1280x720 (30 fps), 640x480, or 320x240)

x1: Record a video and play it at normal speed.

x5: Record a video and play it at 5X normal speed.

x10: Record a video and play it at 10X normal speed.

x20: Record a video and play it at 20X normal speed.

• If you select an option other than x1, sound will not be recorded.

• The available options may differ depending on shooting conditions.

Fader

You can fade in or fade out a scene using the fader function on the camera 
without having to do it on a PC. Set the fade in option to gradually fade in 
at the start of the scene. Set the fade out option to gradually fade out the 
scene. Use the function appropriately and add dramatic effects on your 
videos.

To set fader 
options,

 
In Shooting mode, press [m] → 6 → Fader →  

an option.

Icon Description

Off: Fader function not used.

In: Scene gradually fades in.

Out: Scene gradually fades out.

In-out: The fader function is applied at the start and end of the 
scene.

When you use the fader function, it may take longer to save a file.
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Voice

Sometimes, a muted video is more appealing than the one with sound. 
Turn the voice off to record a muted video. 

To set voice 
options,

 
In Shooting mode, press [m] → 6 → Voice →  

an option.

Wind cut

When you record videos in noisy environments, unintended sounds can 
be recorded in videos. In particular, severe wind noise recorded in videos 
distracts you from enjoying your videos. Use the Wind Cut function to 
remove some surrounding noise in addition to wind noise.

To reduce wind 
sound,

 
In Shooting mode, press [m] → 6 → Wind Cut →  

an option.



Chapter 3
Playback/Editing

Learn about how to play back and edit photos and videos.  
Refer to chapter 6 for editing files on a PC.
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Learn how to view photo and video thumbnails and how to protect or 
delete files.

If you perform no operations for a while, information and icons on the screen 
disappear. When you operate the camera again, they will reappear.

Viewing photos

1 Press [y].

• The most recent file you captured will be displayed.

2 Press [C/F] to scroll through files.

• You can also drag the image left or right to move to another file.

You may not be able to edit or play back files that were captured with other 
cameras, due to unsupported sizes or codecs. Use a computer or another device 
to edit or play back these files.

Viewing image thumbnails

In order to search for photos and videos you want, convert to the 
thumbnail view. The thumbnail view displays multiple images at a time 
so that you can easily look through items you wish to find. You can also 
classify and display files by category, such as date or file type.

Scroll the jog dial to the left to select the thumbnail view 
mode.

(Scroll the jog dial to the right to return to the previous 
mode.)

Searching and managing files
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Viewing files by category

1 In the thumbnail view, press [m] → z → Filter →  
a category.

• You can also touch FILTER to select a category.

* Default

Option Description

All View files normally.

Date* View files by the date they were saved.

Type View files by the file type.

Location
View files by the place they were saved. (Only the 
photos captured with a GPS module have the location 
information.)

2 Select a list to open it.

3 Select a file to view it.

4 Touch  to return to the previous view.

Viewing files as a folder

Continuous and burst shots appear as a folder. Selecting a folder will play 
back all photos automatically. Deleting a folder will delete all photos in the 
folder.

1 In Playback mode, press [C/F] or drag the image left or 
right to move to a desired folder.

• The camera will automatically play back photos in the folder.

2 Scroll the jog dial to the right to open the folder.

• You can also touch the folder on the screen to open the folder.

3 Press [C/F] or drag the image left or right to move to 
another file.

4 Scroll the jog dial to the left to return to Playback mode.
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Protecting files

Protect your files from accidental deletion.

1 In Playback mode, press [m] → z → Protect → Select.

2 Press [C/F] to select a file, and then press [o].

3 Press [f].

You cannot delete or rotate a protected file.

Lock/Unlock all files

Lock or unlock all files.

1 In Playback mode, press [m] → z → Protect → All.

2 Select an option.

Option Description

Lock Lock all files.

Unlock Unlock all files.

Cancel Return to the previous menu.
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Deleting files

Delete files in Playback mode and secure more space on your memory 
card. Protected files are not deleted.

Deleting a single file

You can select a single file and delete it.

1 In Playback mode, select a file, and then press [n].

2 When the pop-up message appears, select Yes.

Deleting multiple files

You can select multiple files and delete them.

1 In Playback mode, press [m] → z → Delete → Select.

• Alternatively, in thumbnails view, press [n], and then select files to 
delete.

2 Select files you want to delete by pressing [C/F], and then 
press [o].

• Press [o] again to cancel your selection.

3 Press [n].

4 When the pop-up message appears, select Yes.
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Deleting all files

You can delete all files on the memory card at once.

1 In Playback mode, press [m].

2 Select z → Delete → All.

3 When the pop-up message appears, select Yes.
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Enlarging a photo

You can enlarge photos when viewing them in Playback mode. You can 
also use the Trim function to extract the portion of the image displayed on 
the screen and save it as a new file.

Magnified area

Magnification (the maximum 

magnification may differ by 

resolution) 

Full Image Crop

Scroll the jog dial to the right to enlarge a photo.  
(Scroll the jog dial to the left to reduce a photo.)

To Do this

Move magnified area Press [D/I/C/F].

Crop the enlarged image Press [f]. (saved as a new file)

Return to the original image Press [o].

Viewing a slide show

You can view photos in a slide show, apply various effects to the slide 
show, and play background music.

1 In Playback mode, press [m].

2 Select z → Slide Show Options.

3 Select a slide show effect option.

• Skip to step 4 to start a slide show with no effects.

* Default

Option Description

Play Mode
Set whether or not to repeat the slide show.  
(One Play*, Repeat)

Interval

• Set the interval between photos. (1 sec*, 3 sec,  
5 sec, 10 sec)

• You must set the Effect option to Off to set the 
interval.

Music Set background audio.

Effect

• Set a scene change effect between photos.

• Select Off to cancel effects.

• When you use the Effect option, the interval 
between photos will be set to 1 second.

Viewing photos
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4 Press [m].

5 Select Start Slide Show.

6 View the slide show.

• Press [o] to pause.

• Press [o] again to resume. 

• Press [m] to stop the slide show and return to Playback mode.

• Press [D/I] to adjust the volume level.

Auto rotating

With Auto Rotate on, the camera automatically rotates photos you have 
captured vertically so they fit the screen horizontally.

To set auto rotate 
options,

 
In Playback mode, press [m] → z → Auto Rotate → 

an option.

Creating a print order (DPOF)

DPOF (Digital Print Order Format) lets you set the print size of a photo and 
the number of copies to be printed. 

The camera saves the DPOF information in the MISC folder of your memory 
card. If you have set DPOF information for your images, you can take the 
memory card to a digital printing shop for printing. You cannot set the 
print order of RAW format files.

Photos with dimensions that are wider than the paper may be cut off 
on the left and right edges. Ensure that your photo dimensions are 
compatible with the paper you select.

1 In Playback mode, select a photo, and then press [m]. 

2 Select z → DPOF. 

3 Press [D/I] to set the number of copies. 

• To select another photo, press [C/F]. 

4 Press [o] to save.



115

Playback/Editing

In Playback mode, you can play a video, capture an image from a video, or 
crop a video to save as another file.

Stop

Video viewing controls

Icon/Button Description

/ /[C]

View previous file/Scan backward. (Each time you 
touch the icon or press the button while playing the 
video, you change the scan speed in this order: 2X, 4X, 
8X.)

/ /[o] Pause or resume playback.

/ /[F]

View next file/Scan forward. (Each time you touch the 
icon or press the button while playing the video, you 
change the scan speed in this order: 2X, 4X, 8X.)

/[D/I] Adjust the volume or mute the sound. 

Trimming a video during playback

1 In Playback mode, scroll to a video, and then touch .

2 Press [o] or touch  to start playing the video.

3 Press [o] or touch  at the point where you want the trimming 
to begin.

4 Press [f] or touch Start Point.

5 Press [o] or touch  to resume playing the video.

6 Press [o] or touch  at the point where you want the trimming 
to end.

Playing videos
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7 Press [f] or touch End Point.

8 Press [f] or touch Trim to trim a video.

• You can adjust the scene to be cropped by dragging the handles 
that appear on the progress bar.

9 When the pop-up message appears, select Yes.

• You cannot trim a video recorded in 3D mode.

• The original video should be at least 10 seconds long.

• The camera will save the edited video as a new file and leave the original 
video intact.

Capturing an image during playback

1 While viewing a video, press [o] or touch  at the point where 
you want to capture an image.

2 Press [f] or touch Capture.

• You cannot capture an image from a video recorded in 3D mode.

• The resolution of the captured image will be the same as the original video.

• The captured image is saved as a new file.
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Perform photo editing tasks, such as resizing, rotating, or reducing red-eye 
effects. Edited photos are saved as new files under different file names. 
Photos captured in some modes cannot be edited with the Image Edit 
function.

To edit images,  
In Playback mode, scroll to a photo, and then touch  →  
an option.

• You can also edit images in Playback mode by selecting a photo, and then 
pressing [f] or [m] → Edit Image. 

• Some images may not be edited with the Image Edit function. In this case, use 
a supplied image editing software.

• The camera will save edited photos as new files.

• When you edit photos, the camera will automatically convert them to a lower 
resolution. Photos that you rotate or resize manually are not automatically 
converted to a lower resolution.

• You cannot edit photos while viewing files as a folder. Open the folder and 
select a photo to edit each photo.

Cropping a photo

1 Touch  → .

2 Drag the corners of the box to adjust the size of the area.

3 Drag the box to move the location of the area.

4 Touch OK.

5 Touch  to save.

Editing photos
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Rotating a photo

1 Touch  → .

2 Touch an option.

Rotate : Right 90°

3 Touch OK.

4 Touch  to save.

The camera will overwrite the original file.

Resizing photos

Change the size of a photo and save it as a new file.

1 Touch  → .

2 Touch an option.

Resize : 10.1M 3:2

3 Touch OK.

4 Touch  to save.

Available resize options differ depending on the original size of the photo.
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Adjusting your photos

You can correct captured photos by adjusting the brightness, contrast, or 
saturation.

1 Touch .

2 Touch an adjusting option.

Icon Description

Original (Reset to the original image)

Auto adjustment

Brightness

Contrast

Saturation

RGB

Color Temperature

Exposure

Hue

3 Press [C/F] to adjust the option.

• You can also drag the slider or touch +/- to adjust the option.

4 Touch OK.

5 Touch  to save.
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Retouching faces

1 Touch  → .

2 Press [C/F] to adjust the option.

• You can also drag the slider or touch +/- to adjust the option.

• As the number increases, the skin tone becomes brighter and 
smoother.

3 Touch OK.

• To cancel correction, touch .

4 Touch  to save.

Reducing red-eye

1 Touch  → . 

2 Touch OK.

• To cancel correction, touch .

3 Touch  to save.
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Applying Smart Filter effects

Apply special effects to your photos.

1 Touch , and then touch an option.

Smart Filter : Vignetting

Option Description

Original No effect

Vignetting
Apply the retro-looking colors, high contrast, 
and strong vignette effect of Lomo cameras.

Miniature
Apply a tilt-shift effect to make the subject 
appear in miniature.

Colored Pencil Apply a colored pencil painting effect.

Watercolor Apply a watercolor painting effect.

Wash drawing Apply a pen and ink drawing effect.

Option Description

Oil Sketch Apply an oil painting effect.

Ink Sketch Apply an ink painting effect. 

Acryl Apply an acryl painting effect.

Negative Apply a negative film effect.

Red Desaturate all colors but red.

Green Desaturate all colors but green.

Blue Desaturate all colors but blue.

Yellow Desaturate all colors but yellow. 

2 Touch OK.

3 Touch  to save.



Chapter 4
Wireless network

Learn how to connect to wireless local area networks (WLANs) and use functions.
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Connecting to a WLAN and configuring network settings

Learn to connect via an access point (AP) when you are in a range of a 
WLAN. You can also configure network settings.

Connecting to a WLAN

1 Rotate the mode dial to B.

2 Select , , , or .

3 Press [m], and then select Wi-Fi Setting.

• In some modes, follow the on-screen instructions until the Wi-Fi 
Setting screen appears.

• The camera automatically searches for available AP devices.

4 Select an AP.

Back

Refresh

Samsung1

Samsung2

Samsung3

Samsung4

• Select Refresh to refresh connectable APs.

• Select Add wireless network to add an AP manually. Your AP name 
must be in English to add the AP manually.

Icon/Option Description

Ad hoc AP

Secured AP

WPS AP

Signal strength

Press [C] or touch to open network setting options.

• When you select a secured AP, a pop-up window appears. Enter the 
required passwords to connect to the WLAN. For information about 
entering text, refer to "Entering text". (p. 127)

• When a login page appears, refer to "Using the login browser".  
(p. 125)

• When you select an unsecured AP, the camera will connect to the 
WLAN.

• If you select a WPS profile supported AP, select  → WPS PIN 
connection, and then enter a PIN on the AP device. You can also 
connect to a WPS profile supported AP by selecting  → WPS 
button connection on the camera, and then pushing the WPS 
button on the AP device.

• The same AP may be listed twice, with different frequencies, 
because your camera supports the dual band function.
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Setting network options

1 In the Wi-Fi Setting screen, move to an AP, and then press 
[F] or touch .

2 Select each option, and then enter the required information.

Option Description

Network Password Enter the network password.

IP Setting Set the IP address automatically or manually.

Manually setting the IP address

1 In the Wi-Fi Setting screen, move to an AP, and then press 
[F] or touch .

2 Select IP Setting → Manual.

3 Select each option, and then enter the required information.

Option Description

IP Enter the static IP address.

Subnet Mask Enter the subnet mask.

Gateway Enter the gateway.

DNS Server Enter the DNS address.
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Using the login browser

You can enter your login information via the login browser when 
connecting to some APs, sharing sites, or cloud servers.

Icon Description

Close the login browser.

Move to the previous page.

Move to the next page.

Stop loading the page.

Reload the page.

• You may not be able to select some items depending on the page you 
connected to. This does not indicate a malfunction.

• The login browser may not close automatically after you log into some pages. 
If this occurs, close the login browser by touching , and then proceed 
with the desired operation.

• It may take longer to load the login page due to the page size or network 
speed. If this occurs, wait until the login information input window appears.
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Network connection tips

• Some Wi-Fi features are not available if you do not insert a memory card.

• The quality of the network connection will be determined by the AP.

• The further the distance between your camera and the AP, the longer it 
will take to connect to the network.

• If a nearby device is using the same radio frequency signal as your 
camera, it may interrupt your connection.

• If your AP name is not in English, the camera may not be able to locate 
the device or the name may appear incorrectly.

• For network settings or a password, contact your network administrator 
or network service provider.

• If a WLAN requires authentication from the service provider, you may 
not be able to connect to it. To connect the WLAN, contact your network 
service provider.

• Depending on the encryption type, the number of digits in the password 
may differ.

• A WLAN connection may not be possible in all surroundings.

• The camera may display a WLAN enabled printer on the AP List. You 
cannot connect to a network via a printer.

• You cannot connect your camera to a network and a TV simultaneously.

• Connecting to a network may incur additional charges. Costs will vary 
based on the conditions of your contract.

• If you cannot connect to a WLAN, try another AP from the available AP 
list.

• A login page may appear when you select free WLANs provided by some 
network service providers. Enter your ID and password to connect to 
the WLAN. For information about registering or the service, contact the 
network service providers.

• Be cautious when you enter personal information for an AP connection. 
Do not enter any payment or credit card information on your camera. 
The manufacturer is not liable for any problem caused by entering such 
information.

• Available network connections may differ by country.

• The WLAN feature of your camera must comply with radio transmission 
laws in your region. To ensure compliance, use the WLAN feature only in 
the country where you purchased the camera.

• The process for adjusting network settings may differ, depending on 
network conditions.

• Do not access a network that you are not authorized to use.

• Before you connect to a network, ensure your battery is fully charged.

• You cannot upload or send files captured in some modes.

• Files that you transfer to another device may not be supported by the 
device. In this case, use a computer to play back the files.



127

Wireless network > Connecting to a WLAN and configuring network settings

Entering text

Learn how to enter text. The icons in the table let you move the cursor, 
change the case, etc. Touch a key to enter it.

Icon Description

Move the cursor.

Stop entering text and return to the previous page.

Change case.

Switch between Symbol/Number mode and the normal mode.

Change the input language.

Enter a space.

Save the displayed text.

Delete the last letter.

• You can use only the English alphabets in some modes, regardless of the 
display language.

• You can enter up to 64 characters.

• The screen may differ depending on the input mode.

• Touch and hold a key to enter the character at the upper right corner of the 
key.
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Saving files to a smart phone automatically

The camera connects to a smart phone that supports the AutoShare 
feature via a WLAN. When you capture a photo with your camera, the 
photo is saved to the smart phone automatically.

• The AutoShare feature is supported by Galaxy series smart phones or Galaxy 
Tab models with the Android 2.2 OS or higher or iOS devices with the iOS 4.3 
or higher. Before using this feature, check the device’s firmware and update it 
if needed.

• You should install Samsung SMART CAMERA App on your phone or device 
before using this feature. You can download the application from Samsung 
Apps, the Google Play Store, or the Apple App Store. Samsung SMART 
CAMERA App is compatible with Samsung camera models manufactured in 
2013 or later.

• This feature is not available with the internal memory in some Shooting 
modes.

• If you set this function, the setting is maintained even when you change the 
Shooting mode.

• This feature may not be supported in some modes or may not be available 
with some shooting options.

1 On the camera, in Shooting mode, press [m].

2 On the camera, select 1 → AutoShare → On.

• If the pop-up message that prompts you to download the 
application appears, select Next.

3 On the smart phone, turn on Samsung SMART CAMERA App.

• For iOS devices, turn on the Wi-Fi feature before turning on the 
application.

4 Select the camera from the list and connect the smart phone 
to the camera.

• The smart phone can connect to only one camera at a time.

5 On the camera, allow the smart phone to connect to your 
camera.

• If the smart phone has been connected to your camera before, it is 
connected automatically.

• An icon that shows the connection status ( ) will appear on the 
camera’s screen.

6 On the camera, capture a photo.

• The captured photo is saved to the camera, and then transferred to 
the smart phone.

• If you recorded a video, it is saved only to the camera.
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The camera connects to a smart phone that supports the MobileLink 
feature via a WLAN. You can easily send photos or videos to your smart 
phone.

• The MobileLink feature is supported by Galaxy series smart phones or Galaxy 
Tab models with the Android 2.2 OS or higher or iOS devices with the iOS 4.3 
or higher. Before using this feature, check the device’s firmware and update it 
if needed.

• You should install Samsung SMART CAMERA App on your phone or device 
before using this feature. You can download the application from Samsung 
Apps, the Google Play Store, or the Apple App Store. Samsung SMART 
CAMERA App is compatible with Samsung camera models manufactured in 
2013 or later.

• When there are no files in the camera memory, you cannot use this feature.

• If you select files from the smart phone, you can view up to 1,000 recent files 
and send up to 150 files at a time. If you select files from the camera, you can 
view files that were selected from the camera. The maximum number of files 
that can be sent varies depending on the storage space of the smart phone.

• When you send Full HD videos using MobileLink feature, you may not be able 
to play back files on some devices.

1 On the camera, rotate the mode dial to B.

2 On the camera, select .

• If the pop-up message that prompts you to download the 
application appears, select Next.

3 On the camera, select a sending option.

• If you select Select Files from Smartphone, you can use your 
smart phone to view and share files stored on the camera.

• If you select Select Files from Camera, you can select files to send 
from the camera.

4 On the smart phone, turn on Samsung SMART CAMERA App.

• For iOS devices, turn on the Wi-Fi feature before turning on the 
application.

Sending photos or videos to a smart phone
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5 Select the camera from the list and connect the smart phone 
to the camera.

• The smart phone can connect to only one camera at a time.

6 On the camera, allow the smart phone to connect to your 
camera.

• If the smart phone has been connected to your camera before, it is 
connected automatically.

7 On the smart phone or camera, select files to transfer from the 
camera.

8 On the smart phone, touch the copy button or on the camera, 
select Share.

• The camera will send the files.
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The camera connects to a smart phone that supports the Remote 
Viewfinder feature via a WLAN. Use the smart phone as a remote shutter 
release with the Remote Viewfinder feature. The captured photo will 
display on the smart phone.

• The Remote Viewfinder feature is supported by Galaxy series smart phones or 
Galaxy Tab models with the Android 2.2 OS or higher or iOS devices with the 
iOS 4.3 or higher. Before using this feature, check the device’s firmware and 
update it if needed.

• You should install Samsung SMART CAMERA App on your phone or device 
before using this feature. You can download the application from Samsung 
Apps, the Google Play Store, or the Apple App Store. Samsung SMART 
CAMERA App is compatible with Samsung camera models manufactured in 
2013 or later.

• This function is not available in 3D mode.

1 On the camera, rotate the mode dial to B.

2 On the camera, select .

• If the pop-up message that prompts you to download the 
application appears, select Next.

3 On the smart phone, turn on Samsung SMART CAMERA App.

• For iOS devices, turn on the Wi-Fi feature before turning on the 
application.

4 Select the camera from the list and connect the smart phone 
to the camera.

• The smart phone can connect to only one camera at a time.

5 On the camera, allow the smart phone to connect to your 
camera.

• If the smart phone has been connected to your camera before, it is 
connected automatically.

6 On the smart phone, set the following shooting options.

Icon Description

Flash option

Timer option

Photo size

Saving location

• While using this feature, some buttons are not available on your 
camera.

• The zoom button and the shutter button on your smart phone will 
not function when using this feature.

• Remote Viewfinder mode supports the  and  photo sizes only.

Using a smart phone as a remote shutter release
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7 On the smart phone, touch and hold  to focus.

• The focus is automatically set to Multi AF.

8 Release  to capture the photo.

• The photo will be resized to 640X360 when it is stored to the smart 
phone.

• When you use this feature, the ideal distance between the camera and the 
smart phone may vary, depending on your surroundings.

• The smart phone must be within 7 m of the camera to use this feature.

• It will take some time to capture the photo after you release  on the smart 
phone.

• The Remote Viewfinder function will deactivate when:

 - there is an incoming call on the smart phone

 - either the camera or the smart phone turns off

 - the memory is full

 - either device loses its connection to the WLAN

 - the Wi-Fi connection is poor or unstable
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Using Auto Backup to send photos or videos

You can send photos or videos that you captured with the camera to a PC 
wirelessly.

Installing the program for Auto Backup on 
your PC

1 Install i-Launcher on the PC. (p. 163)

2 Connect the camera to the PC with the USB cable.

3 When the Auto Backup program icon appears, click it.

• The Auto Backup program is installed on the PC and the 
information about the PC will be stored to the camera. Follow the 
on-screen instructions to complete the installation.

• You can also save the information about the PC to the camera by 
connecting the PC and the camera via Wi-Fi.

4 Remove the USB cable.

Before installing the program, ensure that the PC is connected to a network. 
If no internet connection is available, you must install the program from the 
provided CD.

Sending photos or videos to a PC

1 Rotate the mode dial to B.

2 Select .

• If the the pop-up message that prompts you to download the 
application appears, select Next.

• You must configure the backup PC information to use the Auto 
Backup feature. For more details, refer to "Installing the program 
for Auto Backup on your PC". (p. 133) If the Auto Backup program is 
installed on your PC, save the PC information via USB cable or Wi-Fi 
connection.

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)
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3 Select a backup PC.

• If you have performed a backup before, move to step 4.

4 Select OK.

• To cancel sending, select Cancel.

• You cannot select individual files to backup. This function backs up 
only new files on the camera.

• The backup's progress will be shown on the PC monitor.

• When the transfer is completed, the camera will turn off 
automatically in approximately 30 seconds. Select Cancel to return 
to the previous screen and prevent the camera from turning off 
automatically.

• To turn off your PC automatically after the transfer is complete, 
select Shut down PC after backup.

• To change the backup PC, select .

• When you connect the camera to the WLAN, select the AP that is connected 
to the PC.

• The camera will search for available access points even if you are connecting 
to the same access point again.

• If you turn off the camera or remove the battery while sending files, the file 
transfer will be interrupted.

• While you are using this feature, the shutter control is disabled on your 
camera.

• You can connect only one camera to the PC at a time for sending files.

• The backup may be canceled due to network conditions.

• Photos or videos can be sent to a PC one time only. Files cannot be sent again 
even if you reconnect your camera to another PC.

• When there are no files in the camera memory, you cannot use this feature.

• You must turn off Windows Firewall and any other firewalls before using this 
feature.

• You can send up to 1,000 recent files.

• On the PC software, the server name must be entered in the Latin alphabet 
and can contain no more than 48 characters.

• When multiple file types are created at once, only the image files (JPG) will be 
sent to the PC with this feature.
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5 Select the Name box, enter your name, and then select .

Sender Setting

Name

Save

Email

Reset

6 Select the Email box, enter your email address, and then 
select .

7 Select Save to save your changes.

• To delete your information, select Reset.

You can change settings in the email menu and send photos or videos 
stored on the camera via email.

Changing email settings

In the email menu, you can change settings for storing your information. 
You can also set or change the email password. For information about 
entering text, refer to "Entering text". (p. 127)

Storing your information

1 Rotate the mode dial to B.

2 Select .

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)

3 Press [m].

4 Select Sender Setting.

Sending photos or videos via email
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Setting an email password

1 Rotate the mode dial to B.

2 Select .

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)

3 Press [m].

4 Select Setting Password → On.

• To deactivate the password, select Off.

5 When the pop-up appears, select OK.

• The pop-up disappears automatically even if you do not select OK.

6 Enter a 4-digit password.

7 Enter the password again.

8 When the pop-up appears, select OK.

If you lost your password, you can reset it by selecting Reset on the password 
setting screen. When you reset the information, the previously saved user’s 
setting information, email address, and recently sent email list will be deleted.
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Changing the email password

1 Rotate the mode dial to B.

2 Select .

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)

3 Press [m].

4 Select Change Password.

5 Enter your current 4-digit password.

6 Enter a new 4-digit password.

7 Enter the new password again.

8 When the pop-up appears, select OK.

Sending photos or videos via email

You can send photos or videos stored on the camera via email. For 
information about entering text, refer to "Entering text". (p. 127)

1 Rotate the mode dial to B.

2 Select .

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)

3 Select the Sender box, enter your email address, and then 
select .

• If you have previously saved your information, it will be inserted 
automatically. (p. 135)

• To use an address from the list of previous senders, select  → an 
address.
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4 Select the Receiver box, enter an email address, and then 
select .

• To use an address from the list of previous recipients, select  → an 
address.

• Select  to add additional recipients. You can input up to  
30 recipients.

• Select  to delete an address from the list.

5 Select Next.

6 Select files to send.

• You can select up to 20 files. The total size must be 7 MB or less.

7 Select Next.

8 Select the comment box, enter your comments, and then 
select .

9 Select Send.

• The camera will send the email.

• Even if a photo appears to have transferred successfully, errors with the 
recipient’s email account may cause the photo to be rejected or recognized 
as spam.

• You may not be able to send an email if no network connection is available or 
if your email account settings are incorrect.

• You cannot send an email if the file size exceeds the limit. The maximum 
photo resolution you can send is 2M and the longest video you can upload is 
a video recorded using . If the selected photo resolution is higher than 2M, 
it will be automatically resized to a lower resolution.

• If you cannot send an email because of firewall or user authentication 
settings, contact your network administrator or network service provider.

• When there are no files in the camera memory, you cannot use this feature.

• You can also send an email in Playback mode by pressing [m], and then 
selecting Share(Wi-Fi) → Email.
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Upload your photos or videos to file sharing websites. Available websites 
will be displayed on your camera. To upload files to some websites, you 
must visit the website and register before connecting your camera.

Accessing a website

1 Rotate the mode dial to B.

2 Select .

3 Select a website.

• If the pop-up message that prompts you to create an account 
appears, select OK.

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN,  
it will search for available AP devices. (p. 123)

4 Enter your ID and password to log in.

• For information about entering text, refer to "Entering text".  
(p. 127)

• If you connected to SkyDrive, refer to "Using the login browser".  
(p. 125)

• To select an ID from the list, select  → an ID.

• If you have previously logged in to the website, you may be logged 
in automatically.

You must have an existing account on the file sharing website to use this feature.

Using photo or video sharing websites
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Uploading photos or videos

1 Access the website with your camera.

2 Select files to upload.

• You can select up to 20 files. The total size must be 10 MB or less. 
(On some websites, the total size or number of files may vary.)

3 Select Upload.

• On some websites, you can enter your comments by selecting 
the comment box. For information about entering text, refer to 
"Entering text". (p. 127)

• You can set an upload folder for Facebook by pressing [m], and then 
selecting Upload Folder (Facebook) on the website's list screen.

• You cannot upload files if the file size exceeds the limit. The maximum photo 
resolution you can upload is 2M, and the longest video you can upload is a 
video recorded using . If the selected photo resolution is higher than 2M, 
it will be automatically resized to a lower resolution. (On some websites, the 
maximum photo resolution may vary.)

• The method of uploading photos or videos may differ depending on the 
selected website.

• If you cannot access a website because of firewall or user authentication 
settings, contact your network administrator or network service provider.

• Uploaded photos or videos may be automatically titled with the date they 
were captured.

• The speed of your internet connection may affect how quickly photos upload 
or web pages open.

• When there are no files in the camera memory, you cannot use this feature.

• You can also upload photos or videos to file sharing websites in Playback 
mode by pressing [m], and then selecting Share(Wi-Fi) → a desired 
website.

• You cannot upload videos to some websites.

• When you upload photos to SkyDrive, they will be resized to 2M while 
maintaining their aspect ratios.
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Using AllShare Play to send files

You can upload files from your camera to AllShare Play online storage or 
view files on an AllShare Play device connected to the same AP.

Uploading photos to online storage

1 Rotate the mode dial to B.

2 Select  → Web storage.

• If the guide message appears, select OK.

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device.

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)

• To change the size for uploaded photos, press [m], and then 
select Upload Image Size.

• If you have registered more than one web storage, you can select 
from the list by pressing [m], and then selecting Change Web 
storage.

3 Enter your ID and password, and then select Login → OK.

• For information about entering text, refer to "Entering text". (p. 127)

• To select an ID from the list, select  → an ID.

• If you have previously logged in to the website, you may be logged 
in automatically.

To use this feature, you must create an AllShare Play account and an 
account with an affiliated online storage service using your PC. After 
finishing creating accounts, add your online storage account to AllShare 
Play.

4 Select files you want to upload, and then select Upload.

• If you have registered more than one web storage, select a web storage first.

• You cannot upload video files to AllShare Play online storage.

• When there are no files in the camera memory, you cannot use this feature.

• You can upload up to 20 files.

• You can also upload photos in Playback mode by pressing [m], and then 
selecting Share(Wi-Fi) → AllShare Play.
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Viewing photos or videos on devices that 
support AllShare Play

1 Rotate the mode dial to B.

2 Select  → Nearby devices.

• If the guide message appears, select Yes.

• The camera will automatically attempt to connect to a WLAN via 
the most recently connected AP device. 

• If the camera has not previously been connected to a WLAN, it will 
search for available AP devices. (p. 123)

• You can set to allow only selected devices or all devices to connect 
by pressing [m], and then selecting DLNA Access Control on 
the screen.

• A sharing file list is created. Wait until other devices can find your 
camera.

3 Connect the AllShare Play device to a network, and then turn 
on the AllShare Play feature.

• Refer to your device's user manual for more information.

4 On the camera, allow the AllShare Play device to connect to 
your camera.

5 On the AllShare Play device, select a camera to connect.

6 On the AllShare Play device, browse the shared photos or 
videos.

• For information about searching for the camera and browsing the 
photos or videos on the AllShare Play device, refer to the device's 
user manual.

• Videos may not play smoothly depending on the type of AllShare 
Play device or the network condition. For smooth playback, use a 
5Ghz dual-band AP device.

AP

  A camera is connected to a TV that supports AllShare Play via WLAN.
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• You can share up to 1,000 recent files.

• On an AllShare Play device, you can view only photos or videos captured with 
your camera.

• The range of the wireless connection between your camera and an AllShare 
Play device may vary depending on the specifications of the AP.

• If the camera is connected to 2 AllShare Play devices, playback may be slower.

• Photos or videos will be shared in their original sizes.

• You can use this feature only with devices that support AllShare Play.

• Shared photos or videos will not be stored on the AllShare Play device, but 
they can be stored in the camera to meet the device's specifications.

• Transferring photos or videos to the AllShare Play device may take some time 
depending on the network connection, the number of files to be shared, or 
the sizes of the files.

• If you power off the camera abnormally while viewing photos or videos on 
an AllShare Play device (for example, by removing the battery), the device 
considers the camera to still be connected.

• The order of photos or videos on the camera may be different than on the 
AllShare Play device.

• Depending on the number of photos or videos you want to share, it may 
take some time to load your photos or videos and complete the initial set-up 
process.

• While viewing photos or videos on the AllShare Play device, continuously 
using the device's remote or performing additional operations on the device 
may prevent this feature from working properly.

• If you reorder or sort files on the camera while viewing them on an AllShare 
Play device, you must repeat the initial set-up process to update the list of 
files on the device.

• When there are no files in the camera memory, you cannot use this feature.

• We recommend you use a network cable to connect your AllShare Play device 
to your AP. This will minimize any video ‘Stuttering’ you may experience when 
streaming content.

• To view files on an AllShare Play device using the Nearby devices feature, 
enable multicast mode on your AP.
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Sending photos using Wi-Fi Direct

When the camera connects via a WLAN to a device that supports the Wi-Fi 
Direct function, you can send photos to the device. This feature may not be 
supported on some devices.

1 On the device, turn on the Wi-Fi Direct option.

2 On the camera, in Playback mode, scroll to a photo.

3 Press [m], and then select Share(Wi-Fi) → Wi-Fi Direct.

• When in the single image view, you can send only one photo at a 
time.

• When in thumbnails view, you can select multiple photos. Select 
Upload when you are finished selecting photos.

4 Select the device from the camera’s list of Wi-Fi Direct devices.

• Ensure that the device's Wi-Fi Direct option is turned on.

• You can also select your camera from the device's list of Wi-Fi Direct 
devices.

5 On the device, allow the camera to connect to the device.

• The photo will be sent to the device.

• You can send up to 20 files at a time.

• When there are no photos in the camera memory, you cannot use this 
feature.

• If you cannot connect to a Wi-Fi Direct device, update the device with the 
latest firmware. This feature may not be supported on some devices.



Chapter 5
Camera settings menu

Learn about the user settings and general settings menu.  
You can adjust the settings to better suit your needs and preferences.
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You can set the user environment with these settings.

To set user options,  In Shooting mode, press [m] → 5 → an option.

Available items and the order of them may differ depending on shooting 
conditions.

ISO Customizing

ISO Step

You can set the size for the ISO sensitivity by either 1/3 or 1 step.

Auto ISO Range

You can set the maximum ISO value under which each EV step is chosen 
when you set the ISO to Auto.

* Default

Option Value

1/3 Step
ISO 125, ISO 160, ISO 200, ISO 250, ISO 320, ISO 400,  
ISO 500, ISO 640, ISO 800*, ISO 1000, ISO 1250, ISO 1600, 
ISO 2000, ISO 2500, ISO 3200

1 Step ISO 200, ISO 400, ISO 800*, ISO 1600, ISO 3200

Noise Reduction

Use the Noise Reduction to reduce the visual noise in photos.

* Default

Option Description

High ISO NR
This function reduces noise that may occur when you 
set a high ISO sensitivity. (Off, High, Normal*, Low)

Long Term NR
This function reduces noise when you set the camera 
for a long exposure. (Off, On*)

User settings
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Bracket Set

You can set up the options for AE Bracket, WB Bracket, and P Wiz Bracket.

Option Description

AE Bracket Set
Set the exposure interval. (-/+0.3 EV*, -/+0.7 EV, 
-/+1 EV, -/+1.3 EV, -/+1.7 EV, -/+2 EV, -/+2.3 EV, 
-/+2.7 EV, -/+3 EV)

WB Bracket Set

Adjust the White Balance interval range of the  
3 bracketed photos. (AB-/+3*, AB-/+2, AB-/+1,  
MG-/+3, MG-/+2, MG-/+1)

For example, AB-/+3 adjusts the Amber value plus 
or minus three steps. MG-/+3 adjusts the Magenta 
value the same amount.

P Wiz Bracket Set
Select 3 Picture Wizard settings the camera uses to 
capture the 3 bracketed photos.

DMF (Direct Manual Focus)

You can adjust the focus manually by rotating the focus ring after 
achieving the focus by half-pressing [Shutter]. This feature may not be 
available with some lenses.
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Color space

The color space option allows you to select methods for representing 
colors. Digital imaging devices such as digital cameras, monitors, and 
printers have their own methods for representing colors, which are called 
color spaces.

Option Description

sRGB

sRGB (Standard RGB) is an international specification 
to define the color space created by IEC (International 
Electrotechnical Commission). It is widely used for 
creating colors on PC monitors and is also the standard 
color space for Exif. sRGB is recommended for regular 
images and images you intend to publish on the 
Internet.

Adobe RGB

Adobe RGB is used for commercial printing and has a 
larger color range than sRGB. Its wider range of colors 
helps you to easily edit photos on a computer. Note 
that individual programs are generally compatible 
with a limited number of color spaces.

Adobe RGB

sRGB

When the color space is set to Adobe RGB, photos will be saved as  
“_SAMXXXX.JPG”.
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Distortion Correct

You can correct lens distortion that might occur from lenses.  
This feature may not be available with some lenses.

iFn Customizing

You can select options that can be adjusted when you press [i-Function] 
on an i-Function lens.

Option Description

Aperture Set to adjust the aperture value.

Shutter Speed Set to adjust the shutter speed.

EV Set to adjust the exposure value.

ISO Set to adjust ISO sensitivity.

White Balance Set to adjust the White Balance.

Z Set to adjust the zoom ratio.

User Display

You can add or remove shooting information from the display.

1

2

3

London

No. Description

1 
Date & Time
Set to display the date and time.

2 
Icons
Set to display icons on the right in Shooting mode.
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No. Description

3 

Histogram

Set the histogram on the display on or off. 

About histogram

A histogram is a graph that shows the brightness distribution of a 
photo. A histogram inclined to the left indicates a dark photo.  
A histogram inclined to the right indicates a bright photo. The height 
of the graph is related to color information. The graph gets higher if a 
specific color is more common.

Insufficient exposure Balanced exposure Excessive exposure

Key Mapping

You can change the function assigned to the Custom button or DIRECT 
LINK button.

* Default

Button Function

Custom

Set a function of the Custom button.

• Optical Preview*: Execute the Depth of Field 
Preview function for the current aperture value.  
(p. 24)

• One Touch WB (White Balance): Execute the Custom 
White Balance function.

• One Touch RAW +: Save a file in the RAW+JPEG 
format. To save a file in JPEG format, press the button 
again.

• Reset: Reset some settings.

• AEL: Execute the auto exposure lock function.

• AEL Hold: Keep executing the auto exposure lock 
function after shooting.

DIRECT LINK
Set a function of the DIRECT LINK button. 
(AutoShare*, MobileLink, Remote Viewfinder, Auto 
Backup, Email, SNS & Cloud, AllShare Play)
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Grid Line

Select a guide to help you compose a scene.  
(Off*, 3 X 3, 2 X 2, Cross, Diagonal)

AF Lamp

When shooting in dark places, turn the AF lamp on in order to have a 
better auto focus. The Auto Focus functions more accurately in dark places 
when the AF lamp is on.
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Learn to configure your camera's settings.

To set Setting 
options,

 
In Shooting or Playback mode, press [m] → q →  

an option.

* Default

Item Description

Sound

• System Volume: Set the sound volume or turn all sound 
off entirely. (Off, Low, Medium*, High)

Even if the system volume is turned off, the camera emits 
the sound while playing a video or a slide show.

• AF Sound: Set the sound the camera emits when you 
half-press the shutter button on or off. (Off, On*)

• Button Sound: Set the sound the camera emits when 
you press the buttons or touch the screen on or off. (Off, 
On*)

Quick View
Set the Quick View time length – the amount of time the 
camera displays a photo immediately after you capture it. 
(Off, 1 sec*, 3 sec, 5 sec, Hold)

* Default

Item Description

Display 
Adjust

Adjust the display brightness, auto brightness setting, 
display color, or level gauge.

• Display Brightness: You can adjust the display 
brightness manually.

• Auto Brightness: Turn auto brightness on or off.  
(Off, On*)

• Display Color: You can adjust the display color manually.

• Horizontal Calibration: Calibrate the level gauge. If the 
level gauge is not level, position the camera on the level 
surface, and then follow the on-screen instructions.

• You cannot access the Horizontal Calibration option 
in Playback mode.

• You cannot calibrate the level gauge in portrait 
orientation.

Auto Display 
Off

Set the display off time. The display turns off if you do not 
use the camera for the time you set.  
(Off, 30 sec*, 1 min, 3 min, 5 min, 10 min)

Setting
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* Default

Item Description

Power Save

Set power shut off time. The camera shuts off if you do not 
use it for the time you set. (30 sec, 1 min*, 3 min, 5 min,  
10 min, 30 min)

• The camera retains the power-off time setting even if 
you replace the battery.

• Power Save may not work if the camera is connected to 
a computer or a TV or playing a slide show or a movie.

Help Guide 
Display

Set to display help text about menus and functions.  
(Off, On*)

Press [n] to hide the help text.

Language Set a language the camera shows on the display.

Date & Time

Set date, time, date format, time zone and whether to 
imprint the date on photos. (Time Zone, Date & Time, Date 
Type, Time Type, Imprint)

• The date appears on the lower right side of the photo.

• When you print a photo, some printers may not print 
the date appropriately. 

* Default

Item Description

Video Out

Set the video signal output appropriate for your country 
when connecting the camera to an external video device 
such as a monitor or HDTV.

• NTSC: USA, Canada, Japan, Korea, Taiwan, Mexico, etc

• PAL (Supports only PAL B, D, G, H, or I): Australia, Austria, 
Belgium, China, Denmark, Finland, France, Germany, 
England, Italy, Kuwait, Malaysia, New Zealand, Singapore, 
Spain, Sweden, Switzerland, Thailand, Norway, etc

Anynet+ 
(HDMI-CEC)

When you connect the camera to an HDTV that supports 
Anynet+ (HDMI-CEC), you can control the play function of 
the camera with the TV remote control.

• Off: You cannot control the play function of camera with 
the TV remote control.

• On*: You can control the play function of camera with the 
TV remote control.

HDMI Output

When you connect the camera to an HDTV with an HDMI 
cable, you can change the resolution of the image.

• NTSC: Auto*, 1080p, 720p, 480p,  
576p (activates only when PAL is selected)

If the connected HDTV does not support the resolution 
you select, the camera sets the resolution one level lower.
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* Default

Item Description

3D HDMI 
Output

Select an option for playing files on a 3D TV.

• Frame Packing*: Send a file that combines sub-frames 
for the left and right eye into a single packed frame. 

• Side by Side: Send a file that places sub-frames for the 
left and right eye side-by-side.

File Name

Set the method of creating file names.

• Standard*: SAM_XXXX.JPG (sRGB)/ 
_SAMXXXX.JPG (Adobe RGB)

• Date: 
 - sRGB files - MMDDxxxx.JPG. For example, for a photo 

captured on Jan. 01, the file name would be 0101xxxx.jpg.
 - Adobe RGB files - _MDDxxxx.JPG for the months Jan 

through Sept. For the months Oct through Dec, the month 
number is replaced by the letters A (Oct.), B (Nov.) and C 
(Dec.). 
For example, for a photo captured on Feb. 03, the file 
name would be _203xxxx.jpg. For a photo captured on 
Oct. 05, the file name would be _A05xxxx.jpg. 

* Default

Item Description

File Number

Set the method of numbering files and folders.

• Reset: After using the reset function, the next file name is 
started at 0001.

• Series*: New file numbers continue the existing number 
sequence, even if you have installed a new memory card, 
formatted the card, or deleted all photos.

• The first folder name is 100PHOTO, if you have selected 
the sRGB color space and Standard file naming, the first 
file name is SAM_0001.

• File name numbers are increased by 1 from SAM_0001 to 
SAM_9999.

• Folder numbers are increased by 1 from 100PHOTO to 
999PHOTO.

• The maximum number of files that can be saved in one 
folder is 9,999.

• File numbers are assigned according to DCF (Design rule 
for Camera File system) specifications.

• If you change a file name (for example, on a computer), 
the camera will not be able to play the file.

Folder Type

Set the type of folder.

• Standard*: XXXPHOTO

• Date: XXX_MMDD



155

Camera settings menu > Setting

* Default

Item Description

Format

Format the memory card. Formatting deletes all existing 
files including protected files. (Yes, No)

Errors can occur if you use a memory card formatted by 
another brand of camera, a memory card reader, or a 
computer. Please format memory cards in the camera 
before using them to capture photos.

Device 
Information

View the firmware version of the body and the lens, Mac 
address, and network certification number, or update the 
firmware.

• Firmware Update: Update the firmware of the camera 
body or lens. (Body Firmware, Lens Firmware)

• You can download firmware upgrades from  
www.samsung.com.

• You cannot run a firmware upgrade without a fully 
charged battery. Recharge the battery fully before 
running a firmware upgrade.

• If you update the firmware, user settings and values will 
be reset. (Date, time, language, and video out will not 
change.)

• Do not turn the camera off while the update is in 
progress.

* Default

Item Description

GPS

• Geotagging: Set to capture photos with location 
information using the Global Positioning System (GPS). 
Location information is added to the Exif data associated 
with the photo. (Off, On*)

• GPS Valid Time Settings: Set the time to use the last 
location information when the camera fails to receive 
GPS signals. If the camera fails to receive GPS signals after 
the specified time, the location information will not be 
recorded onto the photos. (15 sec*, 30 sec, 1 min, 3 min, 
10 min, 30 min)

• Location Display: Set to display the location information 
on the screen in Shooting mode. The location information 
will appear in Korean only when you are in Korea and 
the display language is set to Korean. When another 
language is set, the location information will appear in 
English. (Off, On*)

• GPS Reset: Set to search for GPS satellites closest to your 
current position. (Yes, No)

To use the GPS function, you must purchase an optional 
GPS device.
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* Default

Item Description

Sensor 
Cleaning

• Sensor Cleaning: Remove dust from the sensor.

• Start-Up Action: When on, the camera performs sensor 
cleaning each time you turn it on. (Off*, On)

As this product uses interchangeable lenses, the sensor 
can get dust on it when you change lenses. This can lead 
to dust particles appearing in the photos you capture. It 
is recommended not to change lenses when you are in a 
particularly dusty area. Also, make sure to attach the lens 
cap to the lens when not using it.

Reset
Reset the setup menu and shooting options to the factory 
defaults. (Date, time, language, and video output settings 
do not change.) (Yes, No)

Open Source 
Licenses

View open source licenses.



Chapter 6
Connecting to external devices

Make full use of the camera by connecting it to external devices such as a computer, HDTV or 3D TV.
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Play back photos or videos by connecting your camera to an HDTV (3D TV) 
using an optional HDMI cable.

Viewing files on an HDTV

1 In Shooting or Playback mode, press [m] → q → HDMI 
Output → an option. (p. 153)

2 Turn off your camera and HDTV.

3 Connect your camera to your HDTV with the optional HDMI 
cable.

4 Turn on your HDTV, and then select the HDMI video source.

5 Turn on the camera.

• The camera automatically enters into Playback mode when you 
connect it to an HDTV.

6 View photos or play videos using the camera buttons.

• When using the HDMI cable, you can connect the camera to an HDTV using 
the Anynet+(CEC) method. 

• The Anynet+(CEC) functions allow you to control connected devices using the 
TV remote control.

• If the HDTV supports Anynet+(CEC), the TV turns on automatically when used 
in conjunction with the camera. This feature may not be available on some 
HDTVs.

• When connected to an HDTV by an HDMI cable, the camera cannot capture a 
photo or video.

• When connected to an HDTV, some of the camera’s playback functions may 
not be available.

• The length of time after which the camera and an HDTV are connected may 
vary depending on the memory card that you are using. As the main feature 
of a memory card is to increase the transfer speed, it is not necessarily true 
to say that a memory card with a faster transfer speed is also fast in using the 
HDMI function.

Viewing files on an HDTV or 3D TV
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Viewing files on a 3D TV

You can view photos or videos captured in 3D mode or with the 3D 
Panorama option in Smart mode on a 3D TV.

1 In Shooting or Playback mode, press [m] → q → HDMI 
Output → an option. (p. 153)

2 Select 3D HDMI Output → an option. (p. 154)

3 Turn off your camera and 3D TV.

4 Connect your camera to your 3D TV with the optional HDMI 
cable.

5 Turn on your 3D TV, and then select the HDMI video source.

6 Turn on your camera.

• The camera automatically enters into Playback mode when you 
connect it to a 3D TV.

7 Move to a 3D file, and then press [I] to switch to 3D mode.

• Press [I] again to switch to 2D Mode.

8 Turn on your TV's 3D function.

• Refer to your TV's user manual for more details.

9 View 3D photos or play 3D videos using the camera buttons.

• You cannot view an MPO file in 3D effect on TVs that do not support the file 
format.

• Use proper 3D glasses when you view an MPO or file or a 3D video file on a 
3D TV.

• Capturing photos in 3D Panorama mode may result in a less pronounced 3D 
effect than those captured in 3D mode with a 3D lens.

Do not view the 3D photos or videos captured by your camera on a 3D TV or 
3D monitor for an extended period of time. It may cause unpleasant symptoms, 
such as eyestrain, fatigue, nausea, and more.
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Transfer files on a memory card to your computer by connecting the 
camera to the PC.

Transferring files to your Windows OS 
computer

Connecting the camera as a removable disk

You can connect the camera to your computer as a removable disk.

1 Turn off the camera.

2 Connect the camera to your computer with the USB cable.

• You must plug the small end of the USB cable into your camera. If the 
cable is reversed, it may damage your files. The manufacturer is not 
responsible for any loss of data.

• If you try to plug the USB cable into the HDMI port, the camera may not 
work properly.

3 Turn on the camera.

• The computer recognizes the camera automatically.

4 On your computer, select My Computer → Removable Disk 
→ DCIM → 100PHOTO or 101_0101.

5 Select the files you want, and then drag or save them to your 
computer.

If the Folder Type is set to Date, the folder name appears as “XXX_MMDD”. 
For example, if you capture a photo on January 1, the folder name will be 
"101_0101".

Transferring files to your computer
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Disconnecting the camera (for Windows XP)

With Windows Vista, Windows 7, and Windows 8, the methods for 
disconnecting the camera are similar.

1 Ensure that no data is being transferred between the camera 
and the computer.

• If the status lamp on your camera is blinking, it means the data 
transfer is in progress. Please wait until the status lamp stops 
blinking.

2 Click  on the tool bar at the bottom right of your computer 
screen.

3 Click the pop-up message.

4 Click the message box indicating safely removed.

5 Remove the USB cable.

Transferring files to your Mac OS

Mac OS 10.5 or later is supported.

1 Turn off the camera.

2 Connect your camera to a Macintosh computer with the USB 
cable.

• You must plug the small end of the USB cable into your camera. If the 
cable is reversed, it may damage your files. The manufacturer is not 
responsible for any loss of data.

• If you try to plug the USB cable into the HDMI port, the camera may not 
work properly.
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3 Turn on the camera.

• The computer recognizes the camera automatically and displays a 
removable disk icon.

4 Open the removable disk.

5 Transfer photos or videos to the Mac OS computer.
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You can view and edit files using the provided programs. You can also send 
the files to a PC wirelessly.

Installing programs from the provided CD

1 Insert the installation CD into your PC.

2 Select a language.

3 Select a program to install.

4 Follow the on-screen instructions.

5 Click Exit to complete the installation.

Available programs when using i-Launcher

Item Description

Multimedia Viewer You can view files with Multimedia Viewer.

Firmware Upgrade You can download the firmware of your camera.

PC Auto Backup
You can send photos or videos that you 
captured with the camera to a PC wirelessly.

Using i-Launcher

i-Launcher allows you to play back files with Multimedia Viewer and 
provides a link to download the PC Auto Backup program.

Requirements for Windows OS

Item Requirements

CPU
Intel® Core™ 2 Duo 2.0 GHz or higher/ 
AMD Phenom™ 2.4 GHz or higher

RAM Minimum 512 MB RAM (1 GB or more recommended)

OS* Windows XP SP2, Windows Vista, Windows 7, Windows 8

Hard disk 
capacity

250 MB or more (1 GB and above recommended)

Others

• CD-ROM drive

• 1024X768 pixels, 16-bit color display compatible 
monitor (1280X1024 pixels, 32-bit color display 
recommended)

• USB 2.0 port

• nVIDIA Geforce 7600GT or higher/  
ATI X1600 series or higher

• Microsoft DirectX 9.0c or higher

*  A 32-bit version of i-Launcher will be installed—even on 64-bit editions of Windows XP, 
Windows Vista, Windows 7, and Windows 8.

Using programs on a PC
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• The requirements are recommendation only. i-Launcher may not work 
properly even when the computer meets the requirements, depending on the 
condition of your computer.

• If your computer does not meet the requirements, videos may not play 
correctly.

The manufacturer is not responsible for any damage that results from using 
unqualified computers such as a computer you assembled yourself.

Requirements for Mac OS

Item Requirements

OS Mac OS 10.5 or higher

RAM
Minimum 256 MB RAM (512 MB or more 
recommended)

Hard disk capacity Minimum 110 MB

Others USB 2.0 port, CD-ROM drive

Opening i-Launcher

On your computer, select Start → All Programs → Samsung → 
i-Launcher → Samsung i-Launcher. Or, click Applications → Samsung 
→ i-Launcher on your Mac OS computer.
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Using Multimedia Viewer

Multimedia Viewer allows you to play back files. From the Samsung 
i-Launcher screen, click Multimedia Viewer.

• Multimedia Viewer supports the following formats:

 - Videos: MP4(Video: H.264, Audio: AAC), WMV(WMV 7/8/9), AVI(MJPEG)

 - Photos: JPG, GIF, BMP, PNG, TIFF, MPO

• Files that have been recorded with other manufacturers’ devices may not play 
back smoothly.

Viewing photos

1

2

3

4567891011

No. Description

1 File name

2 Enlarged area

3 Histogram

4 Open the selected file.

5 Histogram button

6 Rotate to the left/Rotate to the right.

7 Move to the previous file/Move to the next file.

8 Fit the photo to the screen.

9 View the photo in the original size.

10 Zoom in/Zoom out

11 Switches between 2D and 3D mode.
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Viewing videos

1

2

345678

No. Description

1 File name

2 Adjust the volume.

3 Open the selected file.

4 Move to the next file.

5 Stop

No. Description

6 Pause

7 Move to the previous file.

8 Progress bar

Downloading the firmware

From the Samsung i-Launcher screen, click Firmware Upgrade. 

Downloading the PC Auto Backup program

From the Samsung i-Launcher screen, click PC Auto Backup.  
For information about installing the PC Auto Backup program,  
refer to page 133.
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Installing Adobe Photoshop Lightroom

1 Insert Adobe Photoshop Lightroom CD-ROM into your PC. 

2 Select a language. 

3 Follow the on-screen instructions. 

Using Adobe Photoshop Lightroom

Photos captured by a camera are often transformed to JPEG formats and 
stored in the memory according to the settings of the camera at the time 
of shooting. RAW files are not transformed to JPEG formats and are stored 
in the memory without any changes. With Adobe Photoshop Lightroom, 
you can calibrate exposures, White Balances, tones, contrasts, and colors of 
photos. You can also edit JPEG or TIFF files as well as RAW files.

Requirements for Windows OS

Item Requirements

CPU
IntelⓇ PentiumⓇ 4 or AMD AthlonⓇ 64 
processor-based PC

RAM 2 GB

OS Windows Vista, Windows 7(SP 1), Windows 8

Item Requirements

Hard disk capacity 1 GB or more recommended

Others

• DVD-ROM drive (when installing from DVD)

• Internet connection for Internet-based 
services

• 1024x768 display

Requirements for Mac OS

Item Requirements

CPU Multi-core Intel processor (support 64 bit)

RAM 2 GB

OS Mac OS X v10.6.8, 10.7 or 10.8

Hard disk capacity 1 GB or more recommended

Others

• DVD-ROM drive (when installing from DVD)

• Internet connection for Internet-based 
services 

• 1024x768 display

Opening Adobe Photoshop Lightroom

On your computer, select Start → All Programs → Adobe Photoshop 
Lightroom.
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Using the Adobe Photoshop Lightroom interface

For details about the program, click Help → Lightroom Help.

7

5

6

1

2

3

4

No. Description

1 Module selection tab

2 Histogram

3 Editing tools

4 Thumbnail

No. Description

5 Tools for categorizing or selecting files

6 Preview

7 Menu
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Importing files

1 On the program screen, select File → Import Photos and 
Video.

2 Check files you want to import.

3 Select Import. 

Editing images

You can edit colors or tones of your files with Adobe Photoshop 
Lightroom. You can also edit RAW or TIFF format files as well as JPEG files.

1 Select Develop on the module selection tab.

2 Select an image.

3 Adjust the color or tone with the scroll bar.
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Original image Color adjusted

Original image Exposure adjusted

• Check the brightness of the edited image on the histogram screen.

Original image

Exposure adjusted



171

Connecting to external devices > Using programs on a PC

Saving files after converting file formats

1 After editing files, select File → Export.

2 On the Export Location tab, select a folder to save.

3 On the File Settings tab, select an image format. 

4 Select Export to save.



Chapter 7
Appendix

Get information about error messages, camera maintenance,  
trouble shooting tips, specifications, and optional accessories. 
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When the following error messages appear, try these remedies.

Error messages Suggested remedies

Lens is locked
The lens is locked. Rotate the lens counter-clockwise 
until you hear a click. (p. 45)

Card Error

• Turn off your camera, and then turn it on again.

• Remove your memory card and insert it again.

• Format your memory card.

Low Battery Insert a charged battery or recharge the battery.

No Image File
Capture photos or insert a memory card that contains 
photos.

File Error Delete the damaged file or contact a service center.

Memory Full Delete unnecessary files or insert a new memory card.

Card Locked
You can lock SD, SDHC, SDXC, or UHS-1 card to 
prevent files from being deleted. Unlock the card 
when shooting. (p. 177)

Error messages Suggested remedies

Folder and file 
number are max 
values. Replace 
the card

File names do not match the DCF standard. Transfer 
the files on the memory card to your computer and 
format the card. (p. 155)

Error 00
Turn off your camera and remount the lens. If the 
message still appears, contact a service center.

Error 01/02
Turn off your camera, remove the battery, and insert 
again. If the message still appears, contact a service 
center.

Error messages
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Cleaning the camera

Camera lens and display

Use a brush to remove dust and wipe the lens gently with a soft cloth.  
If any dust remains, apply lens cleaning liquid to a piece of cleaning paper 
and wipe gently.

Image sensor

Depending on different shooting conditions, dust may appear in photos 
because the image sensor is exposed to the external environment. This 
problem is normal, and the exposure to dust occurs in everyday use 
of the camera. You can remove dust from the sensor by operating the 
sensor cleaning function. (p. 156) If dust remains after cleaning the sensor, 
contact a service center. Do not insert the blower into the mounting 
opening of the lens.

Camera body

Wipe gently with a soft, dry cloth.

Never use benzene, thinners, or alcohol to clean the device. These solutions can 
damage the camera or cause it to malfunction.

Maintaining the camera
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Using on beaches or shores

• Protect your camera from sand and dirt when you use it on beaches or in 
other similar areas.

• Your camera is not waterproof. Do not handle the battery, adapter, or 
memory card with wet hands. Operating the camera with wet hands 
may cause damage to your camera.

Storing for extended period of time

• When you store the camera for an extended period, place it in a sealed 
container with an absorbent material, such as silica gel.

• Over time, unused batteries will discharge and must be recharged before 
use.

• The present date and time can be initialized when the camera is turned 
on after the camera and battery have been separated for a prolonged 
period.

Using or storing the camera

Inappropriate places to use or store the camera

• Avoid exposing the camera to very cold or very hot temperatures.

• Avoid using your camera in areas with extremely high humidity, or 
where the humidity changes drastically.

• Avoid exposing the camera to direct sunlight and storing it in hot, 
poorly-ventilated areas, such as in a car during summer time.

• Protect your camera and the display from impact, rough handling, and 
excessive vibration to avoid serious damage.

• Avoid using or storing your camera in dusty, dirty, humid, or poorly-
ventilated areas to prevent damage to moving parts and internal 
components.

• Do not use your camera near fuels, combustibles, or flammable 
chemicals. Do not store or carry flammable liquids, gases, or explosive 
materials in the same compartment as the camera or its accessories.

• Do not store the camera where there are mothballs.
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Using the camera with caution in humid environments

When you transfer the camera from a cold environment to a warm one, 
condensation can form on the lens or internal components of the camera. 
In this situation, turn off the camera and wait for at least 1 hour.  
If condensation forms on the memory card, remove the memory card from 
the camera and wait until all moisture has evaporated before reinserting it.

Other cautions

• Do not swing your camera by the strap. This may cause injury to yourself 
or others or damage to your camera.

• Do not paint your camera, as paint can clog moving parts and prevent 
proper operation.

• Turn off the camera when not using it.

• Your camera consists of delicate parts. Avoid impacts to the camera.

• Protect the display from external force by keeping it in the case when 
not in use. Protect the camera from scratches by keeping it away from 
sand, sharp implements, or loose change.

• Do not use the camera if the screen is cracked or broken. Broken glass or 
acrylic could cause injury to your hands and face. Take the camera to a 
Samsung service center to have it repaired.

• Never place cameras, batteries, chargers, or accessories near, on, or 
in heating devices, such as microwave ovens, stoves, or radiators. 
These devices may be deformed and can overheat and cause a fire or 
explosion.

• Do not expose the lens to direct sunlight, as this may discolor the image 
sensor or cause it to malfunction.

• Protect your lens from fingerprints and scratches. Clean your lens with a 
soft, clean, debris-free lens cloth.

• The camera may turn off if impacted from the outside. This is to protect 
the memory card. Turn on the camera to use it again.

• While you use the camera, it may heat up. This is normal and should not 
affect your camera’s lifespan or performance.

• When you use the camera in low temperatures, it may take some time to 
turn on, the color of the display may be changed temporarily, or after-
images may appear. These conditions are not malfunctions and they will 
correct themselves when the camera is returned to milder temperatures.

• Paint or metal on the outside of the camera may cause allergies,  
itchy skin, eczema, or swelling for people with sensitive skin.  
If you experience any of these symptoms, stop using the camera 
immediately and consult a doctor.

• Do not insert foreign objects into any of your camera’s compartments, 
slots, or access points. Damage due to improper use may not be covered 
by your warranty.

• Do not allow unqualified personnel to service the camera or attempt to 
service the camera yourself. Any damage that results from unqualified 
service is not covered by your warranty.
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About memory card

Supported memory card

This product supports SD (Secure Digital), SDHC (Secure Digital High 
Capacity), SDXC (Secure Digital eXtended Capacity), UHS-1 (Ultra High 
Speed-1), microSD, microSDHC, microSDXC, or microUHS-1 memory cards.

Terminal

Write-protect switch

Label (front)

You can prevent files from being deleted by using the write-protect switch 
on an SD, SDHC, SDXC, or UHS-1 card. Slide the switch down to lock or 
slide it up to unlock. Unlock the card when capturing photos and videos.

Memory card adapter

Memory card

To use micro memory cards with this product, a PC, or a memory card 
reader, insert the card into an adapter.
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Memory card capacity

The memory capacity may differ depending on shooting scenes or shooting conditions. These capacities are based on a 2 GB SD card.

Size
Quality

Super Fine Fine Normal RAW RAW + S.Fine RAW + Fine RAW + Normal

Photo

20.0M (5472X3648) 130 163 217 39 30 31 33

10.1M (3888X2592) 277 356 505 - 33 34 35

5.9M (2976X1984) 471 570 727 - 35 36 36

2.0M (1728X1152) 1,053 1,426 1,941 - 37 37 38

Burst 430 514 638 - - - -

16.9M (5472X3080) 153 190 251 - 31 32 34

7.8M (3712X2088) 346 417 568 - 34 35 36

4.9M (2944X1656) 512 670 896 - 36 36 37

2.1M (1920X1080) 1,015 1,349 1,700 - 37 37 37

13.3M (3648X3648) 217 227 284 - 32 33 34

7.0M (2640X2640) 336 465 592 - 35 35 36

4.0M (2000X2000) 559 752 1,203 - 36 37 37

1.1M (1024X1024) 2,149 2,471 2,819 - 38 38 38
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Size
Quality

HQ Normal

Video*

 
1920X1080 (60 fps)

Approx. 10' 10" Approx. 12' 43"

 
1920X1080 (30 fps)

Approx. 17' 41" Approx. 22' 09"

 
1920X1080 (15 fps)

Approx. 23' 38" Approx. 29' 24"

 
1920X810 (24 fps)

Approx. 21' 35" Approx. 27' 02"

 
1280X720 (60 fps)

Approx. 16' 51" Approx. 21' 06"

 
1280X720 (30 fps)

Approx. 29' 11" Approx. 36' 35"

 
640X480 (30 fps)

Approx. 120' 47" Approx. 153' 30"

 
For Sharing (30 fps)

Approx. 218' 48" Approx. 278' 24"

• The figures above are measured without using the zoom function. 

• Available recording time may vary if you use the zoom. 

• Several videos were recorded in succession to determine the total recording time.

• The maximum recording time is 29 minutes and 59 seconds per file.

• The maximum playback time of For Sharing videos is 30 seconds per file.
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• Prevent memory cards from making contact with liquids, dirt, or foreign 
substances. If dirty, wipe the memory card clean with a soft cloth before 
you insert the memory card in your camera.

• Do not allow liquids, dirt, or foreign substances to come in contact with 
memory cards or the memory card slot. Doing so may cause memory 
cards or the camera to malfunction.

• When you carry a memory card, use a case to protect the card from 
electrostatic discharges.

• Transfer important data to other media, such as a hard disk, CD, or DVD.

• When you use the camera for an extended period, the memory card may 
become warm. This is normal and does not indicate a malfunction.

• Use a memory card that meets the standard requirements.

The manufacturer is not responsible for any loss of data.

Cautions when using memory cards

• Avoid memory cards to very cold or very hot temperatures (below  
0 °C/32 °F or above 40 °C/104 °F). Extreme temperatures can cause 
memory cards to malfunction.

• Insert a memory card in the correct direction. Inserting a memory card in 
the wrong direction may damage your camera and memory card.

• Do not use memory cards that have been formatted by other cameras or 
by a computer. Reformat the memory card with your camera.

• Turn off the camera when you insert or remove the memory card.

• Do not remove the memory card or turn off your camera while the lamp 
is blinking, as this may damage your data.

• When the lifespan of a memory card has expired, you cannot store any 
more photos on the card. Use a new memory card.

• Do not bend, drop, or subject memory cards to heavy impact or 
pressure.

• Avoid using or storing memory cards near strong magnetic fields.

• Avoid using or keeping memory cards in areas with high temperature, 
high humidity, or corrosive substances.
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• Do not rest the device on flammable surfaces, such as bedding, carpets, or 
electric blankets for a prolonged period.

• When the device is switched on, do not leave it in any confined space for a 
prolonged period.

• Do not allow battery terminals to come in contact with metallic objects, such 
as necklaces, coins, keys, or watches.

• Use only authentic, manufacturer-recommended, Lithium-ion replacement 
batteries.

• Do not disassemble the battery or puncture the battery with any sharp 
object.

• Avoid exposing the battery to high pressure or crushing forces.

• Avoid exposing the battery to major impacts, such as dropping it from high 
places.

• Do not expose the battery to temperatures of 60 °C (140 °F) or above.

• Do not allow the battery to come in contact with moisture or liquids.

• Battery shall not be exposed to excessive heat such as sunshine, fire or the 
like.

Disposal guidelines

• Dispose of the battery with care.

• Do not dispose of the battery in a fire.

• Disposal regulations may differ by country or region. Dispose of the battery in 
accordance with all local and federal regulations.

Guidelines for charging the battery

Charge the battery only by the method described in this user manual.  
The battery can ignite or explode if not charged properly.

About the battery

Use only Samsung-approved batteries.

Battery specifications

Item Description

Model BP1130

Type Lithium-ion battery

Cell capacity 1,130 mAh

Voltage 7.6 V

Charging time (When the battery 
is completely discharged)

Approx. 150 min

Personal injury or death can occur if the battery is handled carelessly or 
improperly. For your safety, follow these instructions for proper battery 
handling:

• The battery can ignite or explode if not handled properly. If you notice 
any deformities, cracks, or other abnormalities in the battery, immediately 
discontinue use of the battery and contact your manufacturer.

• Use only authentic, manufacturer-recommend battery chargers and charge 
the battery only by the method described in this user manual.

• Do not place the battery near heating devices or expose to excessively warm 
environments, such as the inside of an enclosed car in the summertime.

• Do not place the battery in a microwave oven.

• Avoid storing or using the battery in hot, humid places, such as spas or 
shower enclosures.
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Battery life

Shooting mode Average time / Number of photos

Photos Approx. 160 min/Approx. 320 photos

Videos
Approx. 100 min (Record videos at 1920X1080 
resolution and 60 fps.)

• The figures above are based on Samsung’s test standards.  
Your results may differ depending on your actual usage.

• Available shooting time differs depending on background, shooting 
interval, and use conditions.

• Several videos were recorded in succession to determine the total 
recording time.

Low battery message

When the battery has fully discharged, the battery icon will turn red and 
the "Low Battery" message will appear.

Notes about using the battery

• Avoid exposing batteries to very cold or very hot temperatures (below 
0 °C/32 °F or above 40 °C/104 °F). Extreme temperatures can reduce the 
charging capacity of your batteries.

• When you use the camera for an extended period, the area around the 
battery chamber may become warm. This does not affect the normal use 
of the camera.

• Do not pull the power supply cord to disconnect the plug from the 
power outlet, as this may cause a fire or electric shock.

• In temperatures below 0 °C/32 °F, battery capacity and battery life may 
decrease.

• Battery capacity may decrease in low temperatures, but will return to 
normal in milder temperatures.

• Remove the batteries from your camera when storing it for an extended 
period. Installed batteries may leak or corrode over time and cause 
serious damage to your camera. Storing the camera for extended 
periods with the battery installed causes the battery to discharge. You 
may not be able to recharge a fully discharged battery.

• When you do not use the camera for an extended period (3 months or 
more), check the battery and recharge it regularly. If you let the battery 
discharge continually, its capacity and life may decrease, which can lead 
to a malfunction, fire, or explosion.



183

Appendix > Maintaining the camera

Cautions about using the battery

Protect batteries, chargers, and memory cards from damage.

Prevent batteries from making contact with metal objects, as this can 
create a connection between the + and – terminals of your battery and 
lead to temporary or permanent battery damage and may cause a fire or 
electric shock.

Notes about charging the battery

• If the status lamp is off, make sure that the battery is inserted correctly.

• If the camera is on while charging, the battery may not fully charge. Turn 
off the camera before charging the battery.

• Do not use your camera when you are charging the battery. This may 
cause a fire or electric shock.

• Do not pull the power supply cord to disconnect the plug from the 
power outlet, as this may cause a fire or electric shock.

• Let the battery charge for at least 10 minutes before turning on the 
camera.

• If you connect the camera to an external power source when the battery 
is depleted, using high energy-consuming functions will cause the 
camera to turn off. To use the camera normally, recharge the battery.

• If you reconnect the power cable when the battery is fully charged, the 
status lamp turns on for approximately 30 minutes.

• Using the flash or recording videos depletes the battery quickly. Charge 
the battery until the red status lamp turns off.

• If the status lamp blinks in red, reconnect the cable, or remove the 
battery and insert it again.

• If you charge the battery when the cable is overheated or the 
temperature is too high, the status lamp may blink in red. Charging will 
start when the battery cools down.

• Overcharging batteries may shorten battery life. After charging is 
finished, disconnect the cable from your camera.

• Do not bend or place heavy objects on the AC cable. Doing so may 
damage the cable.
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Notes about charging with a computer connected

• Use only the provided USB cable.

• The battery may not charge when:
 - you use a USB hub
 - other USB devices are connected to your computer
 - you connect the cable to the port on the front side of your computer
 - the USB port of your computer does not support the power output standard  

(5 V, 500 mA)

Handle and dispose of batteries and chargers with care

• Never dispose of batteries in a fire. Follow all local regulations when you 
dispose of used batteries.

• Never place batteries or cameras on or in heating devices, such as 
microwave ovens, stoves, or radiators. Batteries may explode when they 
are overheated.
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Before contacting a service center

If you are having trouble with your device, try these troubleshooting 
solutions before contacting a service professional.

When you leave your camera at a service center, be sure to also leave the other 
components that may have contributed to the malfunction, such as the memory 
card and battery. 

Situation Suggested remedies

Cannot turn on the 
camera

• Ensure that the battery is inserted.

• Ensure that the battery is inserted correctly.

• Charge the battery.

The power turns off 
suddenly

• Charge the battery.

• Your camera may be in Power save mode or the 
display turns off automatically. (p. 153)

• The camera may be turned off automatically to 
prevent the memory card from being damaged 
due to excessive heat. Turn on your camera 
again.

The camera is losing 
battery power quickly

• The battery may lose power more quickly in 
low temperatures (below 0 °C/32 °F). Keep the 
battery warm by putting it into your pocket. 

• Using the flash or recording videos depletes the 
battery quickly. Recharge if needed.

• Batteries are consumable parts that must be 
replaced over time. Get a new battery if the 
battery life is diminishing quickly.

Situation Suggested remedies

Cannot capture 
photos

• There is no space on the memory card. Delete 
unnecessary files or insert a new card.

• Format the memory card.

• The memory card is defective. Get a new 
memory card.

• The memory card is locked. Unlock the card.  
(p. 177)

• Ensure that the camera is switched on.

• Charge the battery.

• Ensure that the battery is inserted correctly.

The camera freezes Remove the battery and insert it again.

The camera heats up
While using the camera, it may heat up.  
This is normal and should not affect your camera’s 
lifespan or performance.

The flash fires 
unexpectedly

The flash may fire due to static electricity.  
The camera is not malfunctioning. 

The flash does not 
work

• The flash option may be set to Off. (p. 94)

• You cannot use the flash in some modes.

The date and time are 
incorrect

Set the date and time under the q menu.  
(p. 153)

The display or buttons 
do not work

Remove the battery and insert it again.
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Situation Suggested remedies

The memory card has 
an error

• Turn off your camera, and then turn it on again.

• Remove your memory card, and then insert it 
again.

• Format your memory card.

See "Cautions when using memory cards" for 
more details. (p. 180)

Your computer does 
not recognize an SDXC  
or UHS-1 memory card

SDXC and UHS-1 memory cards use the exFAT file 
system. To use SDXC or UHS-1 memory cards on 
a Windows XP computer, download and update 
the exFAT file system driver from the Microsoft 
website.

Your TV or computer 
cannot display photos 
and videos that are 
stored on an SDXC or 
UHS-1 memory card

SDXC and UHS-1 memory cards use the exFAT 
file system. Ensure that the external device is 
compatible with the exFAT file system before 
connecting the camera to the device.

Cannot display files

If you change the name of a file, your camera may 
not play the file (the name of the file should meet 
the DCF standard). If you encounter this situation, 
display files on your computer.

The photo is blurry

• Ensure that the focus option you set is suitable 
for the kind of shot you are capturing.

• Use a tripod to prevent your camera from 
shaking.

• Ensure that the lens is clean. If not, clean the 
lens. (p. 174)

Situation Suggested remedies

The colors in the 
photo do not match 
the actual scene

An incorrect White Balance can create unrealistic 
color. Select the proper White Balance option to 
suit the light source. (p. 76)

The photo is too 
bright or too dark.

Your photo is overexposed or underexposed.

• Adjust the aperture value or the shutter speed.

• Adjust the ISO sensitivity. (p. 75)

• Turn off or on the flash. (p. 94)

• Adjust the exposure value. (p. 102)

Photos are distorted

This camera can have minute distortion when 
using a wide-angle lens that enables shooting 
with a wide angle of view. This is normal, and 
does not cause malfunction.

Playback screen does 
not appear on the 
connected external 
device

• Ensure that HDMI cable is properly connected 
to the external monitor.

• Ensure that the memory card is properly 
recorded.

Your computer does 
not recognize your 
camera

• Ensure that the USB cable is connected 
correctly.

• Ensure that your camera is switched on.

• Ensure that you are using a supported 
operating system.

Your computer 
disconnects the 
camera while 
transferring files

The file transfer may be interrupted by static 
electricity. Disconnect the USB cable and connect 
it again. 
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Situation Suggested remedies

Your computer cannot 
play videos

Videos may not play on some video player 
programs. To play video files captured with your 
camera, use the Multimedia Viewer program that 
you can install with the i-Launcher program on 
your computer.

i-Launcher is not 
functioning properly

• End i-Launcher and restart the program.

• Depending on your computer's specifications 
and environment, the program may not 
launch automatically. In this case, click 
Start → All Programs → Samsung → 
i-Launcher → Samsung i-Launcher on your 
Windows computer. (For Windows 8, open 
Start screen, and then select All apps → 
Samsung i-Launcher.) Or, click Applications 
→ Samsung → i-Launcher on your Mac OS 
computer.

Cannot set the DPOF 
for RAW files

You cannot set the DPOF for RAW files.

Auto Focus does not 
work

• Subject is not in focus. When the subject is 
outside the AF area, shoot by moving the 
subject inside the AF area and half-pressing 
[Shutter].

• Subject is too close. Step back from the subject 
and shoot.

• The focus mode is set to MF. Switch the mode 
to AF.

Situation Suggested remedies

AEL feature does not 
work

AEL feature does not work in t, M, i, 
and s modes. Select another mode to use this 
feature.

Lens does not work
• Ensure that the lens is properly mounted. 

• Remove the lens from the camera and  
re-mount it.

External flash or GPS 
does not work

Ensure that the external device is properly 
mounted and turned on.

The date & time 
settings screen 
appears when you 
power on the camera

• Set the date and time again.

• This screen appears when the camera’s internal 
power source is completely discharged. Insert 
a fully charged battery and wait at least 72 
hours in power off status for the internal power 
source to be recharged.
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Image Sensor

Type CMOS

Sensor size 23.5 X 15.7 mm

Effective pixels Approx. 20.3 mega-pixels

Total pixels Approx. 21.6 mega-pixels

Color filter RGB primary color filter

Lens Mount

Type Samsung NX Mount

Available lens Samsung lenses

Image Stabilization

Type Lens shift (depends on lens)

Mode Off/Mode 1/Mode 2

Distortion Correct

Off/On (depends on lens)

i-Function

E, Z (X1.2, 1.4, 1.7, 2.0)

Dust Reduction

Type Super sonic drive

Display

Type
AMOLED with Touch Panel (C-type Touch Control 
Enabled)

Size 3.31" (Approx. 84.0 mm)

Resolution WVGA (800X480) 768 k dots (PenTile)

Field of view Approx. 100 %

Angle Tiltable (Up 90°, Down 45°)

User display
Grid Line, Icons, Histogram, Distance Scale, Level 
gauge

Focusing

Type Phase Detection & Contrast AF

Focusing point

• Total AF point: 105 points (Phase Detection 
AF), 247 points (Contrast AF)

• Selection: 1 point (Free selection)

• Multi: Normal 21 (3 X 7) points (Cross point 1), 
Close up 35 points

• Face detection: Max. 10 faces 

Mode
 Single AF, Continuous AF, Manual Focus, Touch 
AF & Shutter

AF Assist Lamp Green LED
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Shutter

Type 
Electronically controlled vertical-run focal plane 
shutter

Speed

• Auto: 1/6,000–30 sec.

• Manual: 1/6,000–30 sec. (1/3 EV Step)

• Bulb (time limit: 4 min)

Exposure

Metering system

TTL 221 (17 X 13) Block segment

Metering: Multi, Center-weighted, Spot

Metering range: EV 0–18 (ISO100 · 30 mm, F2)

Compensation ±3 EV (1/3 EV Step)

AE lock CUSTOM key

ISO equivalent

• 1 Step: Auto, ISO 100, ISO 200, ISO 400,  
ISO 800, ISO 1600, ISO 3200, ISO 6400,  
ISO 12800, ISO 25600

• 1/3 Step: Auto, ISO 100, ISO 125, ISO 160,  
ISO 200, ISO 250, ISO 320, ISO 400, ISO 500,  
ISO 640, ISO 800, ISO 1000, ISO 1250,  
ISO 1600, ISO 2000, ISO 2500, ISO 3200,  
ISO 4000, ISO 5000, ISO 6400, ISO 8000,  
ISO 10000, ISO 12800, ISO 25600

Drive Mode

Mode
Single, Continuous, Burst (5M only), Timer, 
Bracket (Auto Exposure, White Balance, Picture 
Wizard)

Continuous shooting
• JPEG: High (8.6 fps), Low (5 fps)

• RAW: High (8.6 fps), Low (5 fps)

Burst shooting
• 10, 15, or 30 frames per second

• Up to 30 shots per shutter-press

Bracket shooting
Auto exposure bracketing (±3 EV),  
White Balance bracketing,  
Picture Wizard bracketing

Self-timer 2–30 sec. (1 second interval)

Shutter release SR2NX02 (via Micro USB port) (optional)

Flash

Type External Flash (Bundle with SEF8A)

Mode
Smart Flash, Auto, Auto Red-eye, Fill in,  
Fill-in Red, 1st Curtain, 2nd Curtain, Off

Guide number 8 (based on ISO 100)

Angle of view 28 mm (35 mm film equivalent)

Sync speed Less than 1/180 sec.



190

Appendix > Camera specifications

Flash EV -2–+2 EV (0.5 EV Step)

External flash
Optional Samsung external flashes:  
SEF42A, SEF220A

Sync terminal Hot-shoe

White Balance

Mode

Auto WB, Daylight, Cloudy, Fluorescent White, 
Fluorescent NW, Fluorescent Daylight, Tungsten, 
Flash WB, Custom Set, Color Temperature 
(Manual)

Micro adjustment Amber/Blue/Green/Magenta 7 steps respectively

Dynamic Range

Off/Smart Range+/HDR

Picture Wizard

Mode
Standard, Vivid, Portrait, Landscape, Forest, 
Retro, Cool, Calm, Classic, Custom1, Custom2, 
Custom3

Parameter Color, Saturation, Sharpness, Contrast

Shooting

Mode
Smart Auto, Program, Aperture Priority,  
Shutter Priority, Manual, Lens Priority, Smart

Smart mode

Beauty Face, Best Face, Landscape, Macro, 
Action Freeze, Rich Tones, Panorama, Waterfall, 
Silhouette, Sunset, Night, Fireworks, Light Trace, 
Creative Shot

Smart Filter
Vignetting, Miniature, Colored Pencil, Watercolor, 
Wash drawing, Oil Sketch, Ink Sketch, Acryl, 
Negative, Red, Green, Blue, Yellow

Size

• JPEG (3:2): 20.0M (5472X3648),  
10.1M (3888X2592), 5.9M (2976X1984),  
5.0M (2736X1824) (Burst mode only),  
2.0M (1728X1152)

• JPEG (16:9): 16.9M (5472X3080),  
7.8M (3712X2088), 4.9M (2944X1656),  
2.1M (1920X1080)

• JPEG (1:1): 13.3M (3648X3648),  
7.0M (2640X2640), 4.0M (2000X2000),  
1.1M (1024X1024)

• RAW: 20.0M (5472X3648)
*  3D mode with 3D lens is available only with 4.1M 

(2688X1512) or 2.1M (1920X1080). 

Quality Super Fine, Fine, Normal

RAW standard SRW (ver.2.0.0)

Color space sRGB, Adobe RGB
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Video

Type MP4 (H.264)

Format Movie: H.264, Sound: AAC

Movie AE mode
Program, Aperture Priority, Shutter Priority, 
Manual 

Movie clip Audio on/off (Shooting time: Max. 29' 59'')

Smart Filter

Vignetting, Miniature, Colored Pencil, Watercolor, 
Wash drawing, Oil Sketch, Ink Sketch, Acryl, 
Negative, Red, Green, Blue, Yellow  
(1920X1080, 1280X720, 640X480, 320X240)

Size
1920X1080, 1920X810, 1280X720, 640X480, 
320X240 (For Sharing)
*  Movie recording with 3D Lens is supported.

Frame rate

60 fps, 30 fps, 24 fps (available only with 
1920X810), 15 fps (available only with some 
Smart Filter options)
*  3D mode with 3D lens is available only with 30 fps. 

Multi Motion
x0.25 (640X480, 320X240 only), x0.5 (1280X720 
(30 fps), 640X480, 320X240 only), x1, x5, x10, x20 

Quality HQ, Normal

Sound Stereo 

Edit Still image capture, Time trimming

Playback

Type
Single image, Thumbnails (15/28), Slide show, 
Movie

Edit
Smart Filter, Red-eye Fix, Backlight, Resize, 
Rotate, Face Retouch, Brightness, Contrast

Smart filter
Vignetting, Miniature, Colored Pencil, Watercolor, 
Wash drawing, Oil Sketch, Ink Sketch, Acryl, 
Negative, Red, Green, Blue, Yellow

Smart filter size

• JPEG (3:2): 5.9M (2976X1984),  
5.0M (2736X1824), 2.0M (1728X1152)

• JPEG (16:9): 6.2M (3328X1872),  
4.9M (2944X1656), 2.1M (1920X1080)

• JPEG (1:1): 6.0M (2448X2448),  
4.0M (2000X2000), 1.1M (1024X1024)

Storage

Media
External memory (optional):  
SD card, SDHC card, SDXC card, UHS-1 card

File format
RAW (SRW (ver.2.0.0)), JPEG (EXIF 2.21), MPO 
(3D), DCF, DPOF 1.1

GPS

Type
Geo-tagging with an optional GPS Module  
(WGS 84)

Feature
• Location name (English and Korean only)

• Google Map link
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Wireless network

Type
IEEE 802.11b/g/n support Dual Band (Smart 
Camera 2.0)

Function
MobileLink, Remote Viewfinder, Auto Backup, 
Email, SNS & Cloud, AllShare Play, AutoShare, 
Wi-Fi Direct

Interface

Digital output USB 2.0 (micro USB jack)

Video output
• NTSC, PAL (selectable)

• HDMI 1.4a: (1080p, 720p, 576p/480p)

External release Yes (micro USB)

External microphone Yes

Power Source

Type
Rechargeable battery: BP1130 (1,130 mAh)
*  The power source may differ depending on your region.

Dimensions (W X H X D)

122 X 63.7 X 40.7 mm (without protrusions)

Weight

284 g (without battery and memory card)

Operating Temperature

0–40 °C

Operating Humidity

5–85 %

Software

i-Launcher, Adobe Photoshop Lightroom

*  Specifications may change without notice to improve performance.
*  Other brands and products names are trademarks of respective owners.
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AP (Access Point)

An access point is a device that allows wireless devices to connect to a 
wired network.

Ad-Hoc network

An ad-hoc network is a temporary connection for sharing files or an 
internet connection and between computers and devices.

AdobeRGB

Adobe RGB is used for commercial printing and has a larger color range 
than sRGB. Its wider range of colors helps you to easily edit photos on a 
computer.

AEB (Auto Exposure Bracket)

This feature automatically captures several images at different exposures 
to help you capture a properly-exposed image.

AEL/AFL (Auto Exposure Lock/Auto Focus Lock)

These features help you lock the exposure or focus on which you want to 
focus or calculate the exposure.

AF (Auto Focus)

A system that automatically focuses the camera lens on the subject. Your 
camera uses the contrast to focus automatically.

AMOLED (Active-matrix organic light-emitting diode) /  
LCD (Liquid Crystal Display)

AMOLED is a visual display that is very thin and light, as it does not 
need backlighting. LCD is a visual display commonly used in consumer 
electronics. This display needs a separate backlight, such as CCFL or LED, to 
reproduce colors.

Aperture

The aperture controls the amount of light that reaches the camera’s sensor.
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Composition

Composition in photography means arranging objects in a photo. Usually, 
abiding by the rule of thirds leads to a good composition.

DCF (Design rule for Camera File system)

A specification to define a file format and file system for digital cameras 
created by the Japan Electronics and Information Technology Industries 
Association (JEITA). 

Depth of field

The distance between the nearest and farthest points that can be 
acceptably focused in a photograph. Depth of field varies with lens 
aperture, focal length, and distance from the camera to the subject. 
Selecting a smaller aperture, for example, will increase the depth of field 
and blur the background of a composition.

DPOF (Digital Print Order Format)

A format for writing printing information, such as selected images 
and number of prints, on a memory card. DPOF-compatible printers, 
sometimes available at photo shops, can read the information from the 
card for convenient printing.

Camera shake (Blur)

If the camera is moved while the shutter is open, the entire image may 
appear blurred. This occurs more often when the shutter speed is slow. 
Prevent camera shake by raising the sensitivity, using the flash, or using 
a faster shutter speed. Alternatively, use a tripod or the OIS function to 
stabilize the camera.

Cloud Computing

Cloud computing is a technology that allows you to store data on remote 
servers and to use them from a device with internet access. 

Color space

The range of colors that the camera can see.

Color temperature

Color Temperature is a measurement in degrees Kelvin (K) that indicates 
the hue of a specific type of light source. As the color temperature 
increases, the color of the light source has a more bluish quality. As the 
color temperature decreases, the color of the light source has a more 
reddish quality. At 5,500 degrees Kelvin, the color of the light source is 
similar to the sun at midday.
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Flash

A speed light that helps to create adequate exposure in low-light 
conditions.

Focal length

The distance from the middle of the lens to its focal point(in millimeters). 
Longer focal lengths result in narrower angles of view and the subject is 
magnified. Shorter focal lengths result in wider angles of view.

Histogram

A graphical representation of the brightness of an image. The horizontal 
axis represents the brightness and the vertical axis represents the number 
of pixels. High points at the left (too dark) and right (too bright) on the 
histogram indicate a photo that is improperly exposed.

H.264/MPEG-4

A high-compression video format established by international standard 
organizations ISO-IEC and ITU-T. This codec is capable of providing good 
video quality at low bit rates developed by the Joint Video Team (JVT).

EV (Exposure Value)

All the combinations of the camera’s shutter speed and lens aperture that 
result in the same exposure. 

EV Compensation

This feature allows you to quickly adjust the exposure value measured by 
the camera, in limited increments, to improve the exposure of your photos.

Exif (Exchangeable Image File Format)

A specification to define an image file format for digital cameras created by 
the Japan Electronic Industries Development Association (JEIDA).

Exposure

The amount of light allowed to reach the camera’s sensor. Exposure is 
controlled by a combination of the shutter speed, the aperture value, and 
ISO sensitivity.
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Metering

The metering refers to the way in which the camera measures the quantity 
of light to set the exposure.

MF (Manual Focus)

A system that manually focuses the camera lens on the subject.  
You can use the focus ring to focus on a subject.

MJPEG (Motion JPEG)

A video format which is compressed as a JPEG image.

MPO (Multi Picture Object)

An image file format that contains multiple images in a file. An MPO file 
provides a 3D effect on MPO-compatible displays, such as 3D TVs or 3D 
monitors.

Image sensor

The physical part of a digital camera that contains a photosite for each 
pixel in the image. Each photosite records the brightness of the light that 
strikes it during an exposure. Common sensor types are CCD (Charge-
coupled Device) and CMOS (Complementary Metal Oxide Semiconductor).

IP (Internet protocol) address

An IP address is a unique number that is assigned to every device that is 
connected to the internet.

ISO sensitivity

The sensitivity of the camera to light, based on the equivalent film speed 
used in a film camera. At higher ISO sensitivity settings, the camera uses a 
higher shutter speed, which can reduce blur caused by camera shake and 
low light. However, images with high sensitivity are more susceptible to 
noise.

JPEG (Joint Photographic Experts Group)

A lossy method of compression for digital images. JPEG images are 
compressed to reduce their overall file size with minimal deterioration of 
the image resolution. 
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Quality

An expression of the rate of compression used in a digital image. Higher 
quality images have a lower rate of compression, which usually results in a 
larger file size.

RAW (CCD raw data)

The original, unprocessed data, collected directly from the camera’s image 
sensor. White Balance, contrast, saturation, sharpness, and other data can 
be manipulated with editing software before the image is compressed into 
a standard file format.

Resolution

The number of pixels present in a digital image. High resolution images 
contain more pixels and typically show more detail than low resolution 
images.

Noise

Misinterpreted pixels in a digital image that may appear as misplaced or 
random, bright pixels. Noise usually occurs when photos are shot with a 
high sensitivity or when a sensitivity is automatically set in a dark place.

NTSC (National Television System Committee) 

A video color encoding standard used most commonly in Japan, North 
America, the Philippines, South America, South Korea, and Taiwan.

Optical zoom

This is a general zoom which can enlarge images with a lens and does not 
deteriorate quality of images.

PAL (Phase Alternate Line)

A video color encoding standard used in numerous countries throughout 
Africa, Asia, Europe, and the Middle East.
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Shutter speed

Shutter speed refers to the amount of time it takes to open and close the 
shutter, and it is an important factor in the brightness of a photo, as it 
controls the amount of light which passes through the aperture before 
it reaches the image sensor. A fast shutter speed allows less time to let 
light in and the photo becomes darker and more easily freezes subjects in 
motion.

sRGB (Standard RGB)

International standard of color space established by the IEC (International 
Electrotechnical Commission). This is defined from color space for PC 
monitors and is also used as the standard color space for Exif.

Vignetting

A reduction of an image’s brightness or saturation at the periphery (outer 
edges) compared to the center of the image. Vignetting can draw interest 
to subjects positioned in the center of an image.

White Balance (Color balance)

An adjustment of the intensities of colors (typically the primary colors red, 
green, and blue), in an image. The goal of adjusting the White Balance, or 
color balance, is to correctly render the colors in an image.

Wi-Fi

Wi-Fi is a technology that allows electronic devices to exchange data 
wirelessly over a network.

WPS (Wi-Fi Protected Setup)

WPS is a technology that secures wireless home networks.
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Lens

SAMSUNG 18-55 mm F3.5-
5.6 OIS III

SAMSUNG 20-50 mm F3.5-
5.6 ED II

SAMSUNG 16 mm F2.4 SAMSUNG 20 mm F2.8

SAMSUNG 30 mm F2 SAMSUNG 50-200 mm F4-
5.6 ED OIS II

SAMSUNG 60 mm F2.8 
Macro ED OIS SSA

SAMSUNG 18-200 mm 
F3.5-6.3 ED OIS

Lens

SAMSUNG 85 mm F1.4 ED SSA SAMSUNG 45 mm F1.8

SAMSUNG 45 mm F1.8 [T6] 2D/3D

External flash

SEF42A SEF220A

GPS

GPS10
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Other accessories

Camera bag

You can purchase the camera bag separately.

Camera case

You can purchase the camera case separately.

Memory card

This product supports SD (Secure Digital), SDHC 
(Secure Digital High Capacity), SDXC (Secure 
Digital eXtended Capacity), UHS-1 (Ultra High 
Speed-1), microSD, microSDHC, microSDXC, or 
microUHS-1 memory cards.

Filter

You can create different colored effects by 
attaching filters to your lens.

USB cable

You can purchase additional USB cables.

HDMI cable

You can view high-definition photos and videos 
by connecting the camera to an HDMI-compatible 
monitor with the HDMI (HDMI type D) cable.

Other accessories

Shutter release (micro USB type)

Shutter release reduces shakiness when used with 
a tripod.

Microphone

Microphone picks up the subject's sound more 
clearly when you record a video with the zoom 
function.

Strap

You can additionally purchase the straps.

Battery pack

You can purchase additional battery packs.

Battery charger

You can charge the battery.

• These illustrations may differ from your actual items. Refer to the user 
manuals of these optional accessories for details. 

• Use only Samsung-approved accessories. Samsung is not responsible for 
damage caused by using another manufacturer’s accessories.
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A

Adobe Photoshop Lightroom  167

AllShare Play  141

Aperture  16, 20

Auto Backup  133

Auto focus  80

B

Battery

Caution  181

Charging  34

Insert  33

Best Face mode  65

Bracketing  92

C

Camera

Connecting as removable disk  160

Connecting to PC  160

Disconnecting (Windows)  161

Layout  30

Camera specifications  188

Charging  34

Color space  148

D

Date & Time  153

Depth of Field (DOF)  17, 22

Digital Print Order Format  
(DPOF)  114

DIRECT LINK  32

Display brightness  152

Display type  43

Drive  90

E

Enlarging  113

Exposure Value (EV)  16, 102

F

Fader  105

Files

Deleting  111

Photo type  74

Protecting  110

Video type  104

Flash

Bounce photography  27

Flash options  94

Guide number  26

Intensity  95

F-number  16

Focal length  21

Focus assist  88

Focus Peaking  88

I

Icons

Playback mode  42

Shooting mode  40

i-Function  61

i-Launcher  163

Image adjustment

Adjusting photos  119

Red-eye  120

Retouching faces  120

ISO sensitivity  75

i-Zoom  63

L

Lenses

Layout  44

Locking  45

Markings  47

Unlocking  46

M

Maintenance  174

Memory card  177

Caution  177

Insert  33

Metering  97

MobileLink  129

Index



202

Appendix > Index

O

One touch shot  87

Optical Image Stabilization  
(OIS)  89

Optional accessories

Attach the GPS module  51

Connect the flash  49

Flash layout  48

GPS module layout  51

P

Panorama mode  66

Photos

Editing  117

Enlarging  113

Shooting options  73

Viewing on 3D TV  159

Viewing on camera  108

Viewing on HDTV  158

Picture Wizard  79

Posture  13

Power save mode  153

R

Red-eye effect

Playback mode  120

Shooting mode  95

Remote Viewfinder  131

Resolution

Playback mode  118

Shooting mode (Movie)  104

Shooting mode (Photo)  73

Retouching faces  120

Rotating  118

Rule of thirds  24

S

Service center  185

Settings  152

Shooting modes

Aperture Priority  57

Lens Priority  60

Manual  59

Program  56

Recording  68

Shutter Priority  58

Smart  64

Smart Auto  54

Shutter speed  18, 20

Slide show  113

Smart filter

Playback mode  121

Shooting mode  101

Smart panel  38

T

Thumbnails  108

Timer  91

Touch AF  86

Touch screen  36

Tracking AF  86

Transferring files

Mac  161

Windows  160

TV  158

U

Unpacking  29

V

Video Out  153

Videos

Capturing  116

Options  104

Recording  68

Viewing  115

W

White balance  76

Wireless network  123

3

3D mode  69
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FCC ID: A3LNX300
FCC Part 15.19 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

FCC Part 15.21 
Any changes or modifications (including the antennas) made to this device that are not expressly approved by the manufacturer may void the user's authority to operate the equipment.

RF Exposure Statement (2.1091) 
FCC RF Radiation Exposure Statement: This equipment complies with FCC RF Radiation exposure limits set forth for an uncontrolled environment. This device and its antenna must not be co-located or operating in conjunction with any other antenna or transmitter.

This equipment should be installed and operated with a minimum distance of 5 mm between the radiator and your body.

RF du FCC d'exposition aux radiations: Cet équipement est conforme à l'exposition de la FCC rayonnements RF limites établies pour un environnement non contrôlé. Cet appareil et son antenne ne doivent pas être co-localisés ou fonctionnant en conjonction avec une autre antenne ou transmetteur. 

Cet équipement doit être installé et utilisé avec une distance minimale de 5 mm entre le radiateur et votre corps.

IC: 649E-NX300
Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radio électrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Part 15.105 (B) : 
Note : This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications, However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: 

- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
- Consult the dealer or an experienced radio/TV technician for help. 

Modifications not expressly approved by the manufacturer could void the user’authority to operated the equipment under FCC rules.  
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Please refer to the warranty that came with your product  
or visit our website www.samsung.com for after-sales service or inquiries.

www.samsung.com

